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Acronyms 

 

1. NLE: Stands for Non-Linear Editing, referring to the use of digital editing software to 

manipulate video and audio clips in a non-linear, random-access manner. 

2. FPS: Stands for Frames Per Second, indicating the number of frames displayed in one 

second of video. The standard frame rate for most video is 24fps, 30fps, or 60fps. 

3. DPI: Stands for Dots Per Inch, referring to the number of dots or pixels that can be 

printed or displayed per inch of screen space. DPI is important when exporting high-

resolution images or videos. 

4. RGB: Stands for Red Green Blue, referring to the additive color model used in digital 

displays to create colors by combining different levels of red, green, and blue light. 

5. NTSC: Stands for National Television System Committee, referring to the standard 

video format used in North America, Japan, and other countries. NTSC has a frame 

rate of 30fps and a resolution of 720x480 pixels. 

6. PAL: Stands for Phase Alternating Line, referring to the standard video format used 

in most of Europe, Australia, and other countries. PAL has a frame rate of 25fps and 

a resolution of 720x576 pixels. 

7. H.264: Refers to a popular video compression codec used for high-quality video 

streaming, digital television, and Blu-ray Discs. H.264 provides efficient compression 

while maintaining high visual quality. 

8. AAC: Stands for Advanced Audio Coding, referring to a popular audio compression 

format used in digital audio and video. AAC provides high-quality audio at lower 

bitrates than other formats like MP3. 

9. LUT: Stands for Look-Up Table, referring to a file that contains color correction and 

grading information used to adjust the colors and tones of a video clip. 

10. VFX: Stands for Visual Effects, referring to the process of creating and manipulating 

visual elements in a video, such as special effects, 3D animation, and compositing. 
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Introduction 

Video editing refers to the process of manipulating and rearranging video footage, audio 

files, and visual effects to create a final product. It involves using software and tools to 

refine and improve raw video material, adding transitions, special effects, and soundtracks 

to create a polished finished product. 

Video editing can be used in a variety of contexts, including film and television production, 

corporate videos, marketing materials, social media content, and personal projects such as 

vlogs or home movies. 

The process of video editing typically involves several steps, including importing and 

organizing footage, selecting the best takes and shots, assembling the footage into a 

coherent sequence, adding visual and audio effects, and color grading and finalizing the 

video. 

With the increasing availability of powerful video editing software and digital cameras, video 

editing has become more accessible to amateur filmmakers and content creators, allowing 

them to produce high-quality video content without the need for a large production team or 

expensive equipment. 

QUESTION: What is editing?  

ANSWER: Editing for motion pictures is the process of organizing, reviewing, selecting, and 

assembling the picture and sound “footage ” captured during production. The result of 

these editing efforts should be a coherent and meaningful story or visual presentation that 

comes as close as possible to achieving the goals behind the original intent of the work — to 

entertain, to inform, to inspire, etc. 

Every motion picture you see on television drama you watch has been edited. Every 

commercial, news report, and talk show has been edited. Almost every presentation of 

motion imagery, whether it is fiction, non-fiction, or a melding of the two, has been edited. 

 A writer pens the story, a director coaches the actors, a cinematographer creates the visual 

style of each shot, and an editor puts all those pieces together. So an editor is really one of 

the last creative people to touch a motion picture project. It is his or her skill, craft, and gut 

instinct that help form the over-arching visual style of the presentation, and often it is also 

his or her choices that can make or break a program. Of course, an editor can only work as 

much magic as he or she is given, meaning that the initial quality and quantity of production 

footage has an awful lot to do with the overall appeal of the final, edited result. 

 But a good editor can make the difference in the overall final visual presentation. 
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1. Import and manage media files 

2. Trim video 
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Learning Unit 1: IMPORT AND MANAGE MEDIA FILES 

 

 

STRUCTURE OF LEARNING UNIT  

Learning outcomes: 

1.1 Proper arrangement of media files on storage devices  
1.2 Right importation of media files 
1.3 Right creation of tracks & timeline 
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Learning Outcome 1.1 Proper arrangement of media files on storage devices  

 

 

 

 

 

Duration: 3hrs 

 Learning Outcome 1 objectives:  

By the end of the learning outcome, the trainees will be able to: 

1  Specify  the drive formats and requirements 

2  Manage  file and folder 

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software: 
Adobe Premiere Pro CC, 
Final Cut Pro, Adobe 
Premiere Clips, Sony Vegas 
Pro, Adobe After Effects, 
DaVinci Resolve, Red Giant, 
Video Copilot 

 

 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD 
Card 

Advance preparation: 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 

. RAW footages 
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Indicative content 1.1.1: The drive formats and  requirements 

 

 
 
✓ Drives formatting  

 NTFS 
  EXFAT  
 FAT 32 
  Mac OS journaled 

✓ Safe Storage 
 Drive status 
  Backup 

 
 
 
  

 

I. Drives formatting 

When you have a new hard drive, or when you're reinstalling Windows, the OS may ask you 

to format the drive. If given a choice, the two common modes are NTFS and FAT32. But 

what are those, and why would you choose one over the other? We break down the 

differences between FAT32 vs. NTFS. 

FAT32 is the older of the two drive formats. FAT32 is the most common version of the FAT 

(File Allocation Table) file system created back in 1977 by Microsoft.  

NTFS (New Technology Files System) is the newer drive format. Microsoft introduced NTFS 

in 1993, as a component of the corporate-oriented Windows NT 3.1 and then Windows 

2000, though it didn't become common on consumer PCs until Windows XP in 2001. 

Windows 7 and 8 default to NTFS format on new PCs. 

Drive formatting is the process of preparing a data storage device, such as a hard drive or a 

USB flash drive, to be used by a computer or other electronic device. The formatting process 

erases all data on the drive and sets up the necessary file system structure for storing new 

data. 
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There are several types of drive formatting, including quick format and full format. A quick 

format only erases the file system information on the drive, while a full format also checks 

the drive for bad sectors and marks them as unusable. 

Formatting can be performed using the built-in formatting tool in an operating system, such 

as Windows or macOS, or through specialized formatting software. Different file system 

formats, such as FAT32, NTFS, or exFAT, are used depending on the intended use of the 

drive, such as for data storage, backup, or booting a computer. 

It is important to note that formatting a drive will erase all data on it, so it should only be 

done when necessary and after backing up any important data. Additionally, some drives, 

such as solid-state drives (SSDs), may have a limited number of write cycles, so frequent 

formatting can shorten their lifespan. 

 II. The Drives Requirements 

Video editing is one of the most demanding tasks you can execute on a computer. A modern 

video-editing program such as Adobe Premiere requires high performance from the 

processor, RAM memory, GPU (if using GPU acceleration), as well as storage drives. 

Choosing a fast storage solution can be a little tougher than picking the fastest computer 

processor, as there are more tradeoffs involved. The largest drives aren’t always the fastest, 

and speeds can vary a great deal. This guide was created to help you choose the right 

storage drive (or drives) for your editing needs, from the small to the large.  

The requirements for drives, such as hard disk drives (HDDs) and solid-state drives (SSDs), 

depend on their intended use and the system they will be installed in. Here are some of 

the factors to consider: 

1. Capacity: The capacity of a drive determines how much data it can store. This is an 

important consideration for personal and business use, as well as for servers and 

other high-capacity storage systems. 

2. Speed: The speed of a drive determines how quickly data can be read from or 

written to it. For example, SSDs are generally faster than HDDs, but they are also 

more expensive. 

3. Interface: The interface of a drive determines how it connects to the system. SATA 

and PCIe are common interfaces for internal drives, while USB and Thunderbolt are 

common interfaces for external drives. 

4. Form factor: The form factor of a drive determines its physical size and shape. For 

example, 2.5-inch and 3.5-inch form factors are common for internal HDDs, while 

M.2 and U.2 form factors are common for internal SSDs. 

5. Durability: The durability of a drive is important for portable drives that will be 

frequently transported. Some drives are designed to withstand shock and vibration, 

while others are not. 

6. Reliability: The reliability of a drive is important for critical applications, such as 

server and enterprise storage. Some drives have higher reliability ratings than 

others, and some come with longer warranties. 
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Overall, it is important to choose a drive that meets the requirements of the system it will 

be used in and the intended use of the drive. This includes considering factors such as 

capacity, speed, interface, form factor, durability, and reliability. 

 External drives 

If you don't have space in your computer for internal drives, then you will need to use an 
external drive. External-drive performance is determined by two factors. First, the actual 
speed of the drive being used is important. The best external single-drive setups use high-
performance 7200 rpm drives, like the ones discussed earlier. If a manufacturer does not 
publish the speed of the internal drive that's used, it’s probably because it's not very fast. 
 

Online vs Nearline vs Offline 

I’m certain you’ve heard these terms used widely when discussing video storage. Here are 
some useful and simple definitions. 

• Online Storage is high speed attached working storage for instant access to active video 
media and other files 

• Nearline Storage is attached storage for short term data that needs to be instantly 
accessible, but doesn’t require the speed of the online storage 

• Offline Storage is medium term storage of data that is not attached or instantly 
accessible. A backup is an example of offline data. 

Before we can dive into different types of video storage, or even strategy and structure, I 
want to define the key differences between a copy, a backup, and an archive. It’s easy to 
blur the lines and think of these all as simply duplication of your video files, but each serves 
a different purpose. 

• Clone is for making data available to use in a different location 
• Backup is for recovery from hardware failure or recent data corruption or loss 
• Archive is for space management and long term retention 

Backup 

• One of multiple copies of data in active use 
• Kept in sync with active storage 
• Should be fast to restore in the event of unrecoverable active online storage failure 
• Intended for short term data retention 
• Retained for as long as data is in active use 

Archive 

• Usually the only remaining copy of data no longer in active use 
• Long term stability is more important than speed of data retrieval 
• Intended for long term retention 
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• Retained indefinitely 
• Data cannot be altered or deleted once archived 

 

 

 

Indicative content1.1.2:  File and folder management 

 

✓ Creation of folders and subfolders 

 Naming Convention 

 Filename Details 

 
 
 
 
 
 
Renaming Convention 
 
File & Folder Naming Conventions 

• The file name should be descriptive of the file. ... 

• Do not use spaces. ... 

• Special characters should be avoided: ~ ! @ # $ ... 

• Only 1 dot per filename and it belongs just prior to the file extension. 

• If a date is included, always use a numeric 8-digit date in the yyyymmdd format. 

 

 

Theoretical learning Activity  

✓ Ask trainees to list and show the use of Drives formatting types. 

Whether you're formatting an internal drive, external drive, USB flash drive, or SD card, 

Windows gives you the choice of using three different file systems: NTFS, FAT32, and exFAT. 

 

✓ Ask trainees: What storage is best for video editing? 
If you need the best portable storage for video editing, use an external SSD such as the 

SanDisk Extreme or Extreme Pro Portable SSD. 
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✓ Ask trainees to Differentiate the following terms a. Clone b. Backup c. Archive. 

Clone is for making data available to use in a different location 

Backup is for recovery from hardware failure or recent data corruption or loss 

Archive is for space management and long term retention 

 

✓ Ask trainees to brainstorm about folder and files renaming convention. 

File & Folder Naming Conventions 

• The file name should be descriptive of the file. 

• Do not use spaces.  

• Special characters should be avoided: ~ ! @ # $ . 

• Only 1 dot per filename and it belongs just prior to the file extension. 

• If a date is included, always use a numeric 8-digit date in the  yyyymmdd format. 

 

Practical learning Activity  

✓ Ask trainees to fill the table using the following items: DropBox, iCloud, Google 
Drive, Microsoft One Drive, Optical discs, external hard drives and USB drives. 

Offline storages Online storages 

USB drives Microsoft  Google Drive 

Optical discs iCloud 

hard drives DropBox 

  

 

 

Points to Remember (Take home message) 

• File & Folder Naming Conventions 

• Remember to differentiate Back up from Archive 

• Do not forget the use of drive formatting 
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Learning Outcome 1.2: Import media files 

 

 

Duration: 4hrs 

 Learning Outcome 1.2 objectives:  

By the end of the learning outcome, the trainees will be able to: 

1  Specify Common steps in importing files 

2  Create  Media Bins/Events 

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software: 
Adobe Premiere Pro CC, 
Final Cut Pro, Adobe 
Premiere Clips, Sony Vegas 
Pro, Adobe After Effects, 
DaVinci Resolve, Red Giant, 
Video Copilot 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

 

Advance preparation: 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 

. RAW footages 
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Indicative content 1.2.1:  Common steps in importing files 

 

 
 

✓ Introduction to editing software  
 Interface  
 Workflow  
 Compatibility with other software 

✓ Open editing software  
✓ Locate media files on storage devices 

 

 

 Introduction to editing software (Adobe premiere pro cc) 
 
I. What is the interface of Adobe Premiere Pro? 
 
Adobe Premiere Pro uses a docked, panel-based interface. The entire interface 
configuration is called a workspace; the application has five pre-built workspaces to 
accommodate different working styles and the different tasks you need to accomplish. 
 

There are three main ways to import files.  
 

1. Standard import  
 
Standard import by choosing File > Import This is the straightforward version of importing 
and is very similar to the way other applications import files. The keyboard shortcut for this 
is Cmd +I [Ctl+I], which opens the standard Import dialog. 

2. Import using Media Browser 
 
Some files will perform better in Premiere if you import using the Media Browser. The 
Media Browser in Adobe Premiere Pro allows you to easily browse for files on your 
computer, then import them – and all their related files – into Premiere. It can also stay 
open all the time, giving you an immediate and optimized to locate and import footage. 
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This is the preferred way to import many camera-formatted files, such as AVCHD, which 
often use complex folder structures with separate files for audio and video. This process 
also mates video files with associated metadata generated by some cameras. The media 
browser is like a directory browser, with forward and back buttons for easy navigation.  
To import from the Media Browser, simply select a clip (or folder) and drag it into your 
project panel or double-click the file (or folder To view a panel full screen click on the panel 
so it is highlighted in blue, then press the tilde (~) key (it’s above the tab key on the left side 
of the keyboard).   
To exit full screen type tilde (~) again or click escape. This is especially useful when using the 
navigation tool in the Media Browser or trying to view clip thumbnails in the Project tab. 
This is also how you play back video full screen in Premiere. Pressing tilde (~) maximizes the 
panel within Premiere, clicking Control tilde (~) makes the video completely fill the screen. 

3. Select and drag files from finder into the Premiere project panel 
 
This is the import method most likely to result in an error, which is why it is listed as the 
third choice. That being said, it is possible to simply drag files into the project panel. We 
strongly recommend using the media browser to import AVCHD files. 
SETTING APPLICATION PREFERENCES 

 

Application preferences control the overall functionality of Premiere Pro, and you can edit 
them at any time. The application preferences allow you to change nearly any aspect of the 
program, from the default length of transitions and still images, to the interface color and 
the frequency and number of automatic backups made for your projects. 

In this section, you will configure the auto-save feature to make more copies of your project 
file at shorter intervals. 

1 Choose Edit > Preferences > General (Windows) or Premiere Pro > Preferences > General 
(Mac OS) to open the Preferences dialog box. 

2 From the list of categories on the left, choose Auto Save to view the preferences for how 
Premiere Pro automatically backs up your files. 

There are two settings for the application’s Auto Save functionality: Automatically Save 
Every and Maximum Project Versions. 

3 Change the value of the Automatically Save Every property to 10 minutes, and then 
change the value of Maximum Project Versions to 20 and click OK. This increases the 
frequency of the Auto Save function, while creating more project versions so you have a 
greater choice of file back-ups. While most users will admit that auto-save is a great feature, 
not all can agree on the best frequency for saving files. When the application runs the auto-
save command, it can interrupt what you are doing and some users find this quite 
distracting. 

What is an Adobe® Premiere Pro Workflow? 
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An Adobe Premiere Pro Workflow can be divided into three different main components: 
• Ingest and acquisition of media  

• Creative editing of media  

• Delivery of finished media  

 

 

Indicative content 1.2.2:  Creation of Media Bins/Events  

 

 

✓ Filename details  

✓ Arrangement of bins/events 

 
 
 
Bins: 
1. Have the same icon as a folder on your hard drive and work almost the same way. 
 2. Store your clips in a more organized way, by dividing them into groups. 
 3. Bins do not exist outside the Premiere project. You will not see them on your hard 
drive. 
 
Creating bins: 
1. Click the ‘New Bin’ button at the bottom of the Project panel. 
 2. Name your Bin.  
3. Also you can create a Bin using File menu. Choose File-New-Bin. 
 4. Also you can create a Bin by right-clicking a blank area in the Project panel and 
choosing New Bin.  
5. The quickest and easiest way to create a new Bin for your clips you already have in 
your project is to drag and drop the clips onto the New Bin button at the bottom of 
the Project panel. 
 

Theoretical learning Activity  

1. What is the interface of Adobe Premiere Pro? 
Adobe Premiere Pro uses a docked, panel-based interface 

2. What are three main ways to import files?  
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a. Standard import  
b. Import using Media Browser 
c. Select and drag files from finder into the Premiere project panel 

3. What are the four defaults components of Adobe premiere pro? 

• Source Monitor. 

• Program Monitor panel. 

• Project panel 

• Timeline panel. 
 

Practical learning Activity  

✓ Ask  Trainees in pair to perform: 

Open Adobe premiere pro installed in your computer, create sequence call it your group 
name, in project panel ask every group member to create bin and call it his/her name.  

Points to Remember (Take home message) 

 

 

• Remember  importation procedures 

• Remember Common click and drag disasters  

• Remember the defaults premiere pro panels 

• Remember  the right ways of Bins creation  
 

 

Learning Outcome 1.3: Create tracks and timeline  

Duration: 3hrs 
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Indicative content1.3.1: Timeline management 

 

 Learning Outcome 3 objectives:  

By the end of the learning outcome, the trainees will be able to: 

1    Manage properly Timeline as found in premiere pro 

2  Manage  Audio/Video tracks 

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player,  

Sound recorder 

 

Video editing software: 
Adobe Premiere Pro CC, 
Final Cut Pro, Adobe 
Premiere Clips, Sony Vegas 
Pro, Adobe After Effects, 
DaVinci Resolve, Red Giant, 
Video Copilot 

 

 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD 
Card 

Advance preparation: 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 

. RAW footages 
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Create a new sequence 

Each sequence has a specific image size and number of frames per second, or frame rate. 
You can create as many sequences as you like in a project, but you will usually work with 
just one master sequence to create your video. 

• To create a new sequence, click the New Item menu in the Project panel and 
choose Sequence from the drop-down menu. Choose a preset based on the camera you 
used to record your videos. Don’t worry if you choose the wrong setting; the first time you 
add a clip to the sequence, you can choose to adjust the settings to match the clip. 

• You can also create a new sequence based on a clip’s properties by dragging the clip onto 
the New Item menu in the Project panel. 

• You can check the sequence’s frame size and frame rate by viewing it in the Project panel 
using List view. 

 
 
 
 

 
 

Indicative content1.3.1: Audio/Video tracks management 

 

 
 
 

➢ Adding audio tracks 

You can control the number of video tracks and the number and type of audio tracks by 

creating a custom preset. After you start editing, you can always add and delete tracks as 

needed. 

To add a single video or audio track 

✓ Project settings  
✓ Timeline creation  

 

✓ Adding audio tracks 

✓ Adding video tracks 
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1. To add a single video track, right-click the video track header area  and choose Add 
Track . Premiere Pro adds a video track. 

 

 Right-click the video track header area. 

 

Click to view larger image 

 Choose Add Track. 

2. To add a single audio track, right-click the audio track header area  and choose Add 
Track . Premiere Pro adds an audio track. 

javascript:popUp('/content/images/chap5_9780321929549/elementLinks/05fig21_alt.jpg')
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 Right-click the audio track header area. 

 

 

 

 

 

Theoretical learning Activity  

✓ Ask trainees to brainstorm about features of timeline in Premiere Pro. 

. 
✓ Ask trainees to discuss about tracks are in Premiere pro Time line. 

 

Practical learning Activity   

✓ Ask Trainees in pair to observe the below figure and name track labelled A and B 
then give the function of where labelled C and D. 
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Points to Remember (Take home message) 

➢ Remember the procedures of adding audio and video tracks  
➢ Do not forget how tracks work 
➢ Remember Timeline management  

 

 

 Formative assessment 1 

Written assessment 

Question 1: List down any five (5) storage devices used in recording and saving videos? 

ANSWER  

Video cassettes tapes is magnetic tape for recording and reproducing visual images and 

sound. 

Memory cards is a small, flat flash drive used especially in digital cameras and mobile 

phones. 

CDs is a digital optical disc data storage format that was co-developed by Philips and Sony 

and  

VHS (short for Video Home System) is a standard for consumer-level analog video 

recording on tape cassettes 

MiniDV is a format for storing digital videos.  
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Negative film 

 Question 2: State at least 5 video editing softwares 

Answer: Adobe Premiere Pro CC, Final Cut Pro, Adobe Premiere Clips, Sony Vegas Pro, 

DaVinci Resolve, 

Question 3: Identifying the difference between Clone and Archive ?  

Clone is for making data available to use in a different location  

Archive is for space management and long term retention 

Question 4. Question 1: Write in full the following term 

a. NTFS: New Technology File System  

b. EXFAT: Extensible File Allocation Table  

c. FAT 32: File Allocation Table  

Question 5. What is the interface of Adobe Premiere Pro?  

Adobe Premiere Pro uses a docked, panel-based interface.  

Question 6. Answer by True or False (3 marks) 

a. Bins is a place where you can add your media True  

b. Interface allow you to import and organize your media and preview your video and 

audio footage True  

c. In video editing, workflow is the steps that any video project goes through after it 

stops shooting and before the project is released True  

Question 7: Give the main ways to import files in Premiere pro.?    

1. Standard import   

2.  Import using Media Browser  

3. Select and drag files from finder into the Premiere project panel     

Question 8: What is the Common click, drag and drop disasters file importation?  

Answer: Wrong destinations                                                     
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Learning Unit 2: TRIM VIDEO 

 

 

STRUCTURE OF LEARNING UNIT  

Learning outcomes: 

2.1 Insert media files on timeline  
2.2 Create rough-cut  
2.3 Apply transitions and effects 
2.4. Manage titles  
2.5 Perform clips synchronization and multicamera editing techniques 
2.6  Manipulate clips speed  
2.7 Apply color correction and color grading techniques 

 

 

Learning Outcome2. 1: Insert media files on timeline 

 

Duration: 8hrs 
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Learning outcome 1  objectives:  

By the end of the learning outcome, the trainees will be able to: 

✓ Drag the whole clip  
✓ Manage source panel 
✓ Use Shortcuts keys 

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software: 
Adobe Premiere Pro CC, 
Final Cut Pro, Adobe 
Premiere Clips, Sony Vegas 
Pro, Adobe After Effects, 
DaVinci Resolve, Red Giant, 
Video Copilot 

 

 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD 
Card 

Advance preparation: 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 

. RAW footages 
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Indicative content2.1.1 : Dragging clips to the timeline  

 

✓ Dragging the whole clip  
✓ Managing source panel 

 Drag video only  
 Drag audio only  
 Mark In/Out 
  Add/Remove markers 

✓ Shortcuts keys 

 

Add a clip to a sequence 

You can add clips to a sequence in the following ways: 

✓ Drag the clip from the Project panel or Source Monitor to a Timeline panel or the 

Program Monitor. 

✓ Use the Insert and Overwrite buttons in the Source Monitor to add clips to a 

Timeline panel. Or use the keyboard shortcuts associated with those buttons. 

✓ Automatically assemble a sequence from the Project panel. 

✓ Drag the clip from the Project panel, Source panel, or Media Browser into the 

Program monitor. 

✓ An overwrite edit adds a clip by replacing any frames already in a sequence starting 

from the edit point and extending for the length of the clip. Overwrite is the default 

method when dragging a clip to a sequence or when rearranging clips in a sequence. 

Managing source panel (Target tracks)      

A sequence may contain several video and audio tracks. When you add a clip to a sequence, 
it is important to assign which track or tracks it is to be edited to. You can target one or 
more tracks, for both audio and video. Target tracks depending on the editing method you 
use: editing from the Source Monitor, dragging, or copy/pasting to the timeline. 

✓ In advance of making an insert or overwrite edit, you can map the tracks of a clip 
loaded in the Source Monitor to one or more tracks of a sequence by dragging the 
source track indicator representing each of the source clip’s tracks into one or more 
selected tracks of the sequence. Audio source track indicators can be placed only in 
audio tracks matching the source clip’s channel configuration. For example, the 
audio track indicator for a stereo clip can be placed only in a stereo track in a 
sequence. After the tracks are targeted, edit the clip by pressing the Insert or 
Overwrite buttons (or use the shortcuts). 

✓ When you drag a clip to a sequence as an insert or overwrite edit by dragging, you 
target the track automatically by dropping the clip into the track. You do not need 
to specify tracks in advance. A drag edit is an overwrite edit by default. If you are 
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performing an insert edit with the clip, press Ctrl (Windows) or Command (Mac OS) 
as you drag. As you make the edit, triangles appear showing the affected tracks. 

✓ When you add clips to a sequence by pasting, (or keyboard shortcuts), you must 
specify target tracks in advance. You can target more than one video track or more 
than one audio track at a time. Also, you can choose to target a video track only or 
an audio track only. Click the track or tracks you want to target in the track header 
area of a Timeline panel. The track header area for a targeted track appears 
highlighted. 

 

 Drag video and audio to a sequence 

By default, when dropped into a sequence, the video and audio components of linked clips 
appear in corresponding tracks (for example, Video 1 and Audio 1), unless the audio channel 
type of the clip is incompatible with the target track. In this case, the linked audio appears in 
the next compatible track, or a compatible track is created automatically. 

✓ To drag the video and audio portions of a clip to specific tracks, drag the clip from 

the Source Monitor or Project panel into a Timeline. When the video portion of the 

clip lies above the desired video track, press and hold Shift. Continue holding shift, 

and drag downward past the bar separating video and audio tracks. When the audio 

portion of the clip lies above the desired audio track, release the mouse and release 

Shift. 

✓ To drag the video portion of a clip to the Video 1 track and the audio to any audio 

track, drag the clip from the Source Monitor or Project panel past the line that 

separates the video tracks from the audio tracks. Drop the clip above the audio track 

where you want the audio portion to land. The video portion of the clip will remain 

in the Video 1 track, and the audio portion lands in the desired audio track. 

✓ To perform an overwrite edit, drag the clip from the Source Monitor or Project panel 

to an appropriate track in a Timeline panel at the point you want the clip to start. 

The destination area is highlighted, and the pointer appears with the Overwrite 

icon . 

✓ To perform an insert edit, Ctrl-drag (Windows) or Command-drag (Mac OS) the clip 

from the Source Monitor or Project panel to an appropriate track in a Timeline panel 

at the point you want the clip to start. The destination area is highlighted, and the 

pointer appears with the Insert icon . Arrows appear at the insertion point in all 

tracks. 

✓ To perform an insert edit and shift only target tracks, Ctrl+Alt-drag (Windows) or 

Command+Option-drag (Mac OS) the clip from the Source Monitor or Project panel 

to an appropriate track in a Timeline panel at the point you want the clip to start. 

The destination area is highlighted, and the pointer appears with the Insert icon . 

Arrows appear at the insertion point only in the tracks to which the clip is added. 
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✓ (Roman keyboards only) To zoom into or out of a clip as you drop it into a Timeline 

panel, drag and press the equal sign key (=) to increase the zoom factor or press the 

minus sign key (–) to decrease it. Do not use the keys on the number pad. 

  
The clip will land in a Timeline panel, and a Timeline panel will become active, making it easy 
to playback the clip just added to the sequence. 

Drag video only or audio only to a sequence 

You can add the video track, the audio tracks, or both types of tracks of a clip to a sequence. 
When you drag a clip from the Project panel or from the main viewing area of the Source 
Monitor, you automatically add both types of tracks. If you want to add only one type of 
track, add it from the Source Monitor. 

1. Double-click a clip in a Project panel or Timeline panel to open it in the Source 
Monitor. 

2. In the Source Monitor, do one of the following 

• Select small or whole space using Mark in or Out points 

• To drag only the video track of the clip, drag from the Drag Video Only icon  

• To drag only the audio tracks, first target in the Timeline panel the tracks you want 
to receive the clip audio tracks. Then map the audio tracks you want to use to the 
target audio tracks. Then, drag from the Drag Audio Only icon  

Make three-point and four-point edits 

The Source and Program Monitors provide controls to perform three-point and four-point 
edits—standard techniques in traditional video editing. 

In a three-point edit, you mark either two In points and one Out point, or two Out points 
and one In point. You don’t have to actively set the fourth point; it’s inferred by the other 
three. For example, in a typical three-point edit you would specify the starting and ending 
frames of the source clip (the source In and Out points), and when you want the clip to 
begin in the sequence (the sequence In point). Where the clip ends in the sequence—the 
unspecified sequence Out point—is automatically determined by the three points you 
defined. However, any combination of three points accomplishes an edit. For example, 
sometimes the point where a clip ends in a sequence is more critical than where it begins. In 
this case, the three points include source In and Out points, and a sequence Out point. On 
the other hand, if you need the clip to begin and end at particular points in the sequence—
say, perfectly over a line of voice-over narration—you could set two points in the sequence, 
and only one point in the source. 

In a four-point edit, you mark source In and Out points and sequence In and Out points. A 
four-point edit is useful when the starting and ending frames in both the source clip and 
sequence are critical. If the marked source and sequence durations are different, Premiere 
Pro alerts you to the discrepancy and provides alternatives to resolve it. 

Make a three-point edit 

1. In a Project panel, double-click a clip to open it in the Source Monitor. 
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2. Click the headers of the tracks in a Timeline panel into which you want to add the 
clip to target them. 

3. In the Timeline, drag the source track indicators to the headers of the tracks into 
which you want the clip components to fall. 

4. In the Source and Program Monitors, mark any combination of three In and Out 
points. 

5. In the Source Monitor, do one of the following: 

  

• To perform an insert edit, click the Insert button . 

• To perform an overwrite edit, click the Overwrite button . 

Make a four-point edit 

1. In a Project panel, double-click a clip to open it in the Source Monitor. 

2. Click the headers of the tracks in a Timeline panel into which you want to add the 
clip to target them. 

3. In the Timeline, drag the source track indicators to the headers of the tracks into 
which you want the clip components to fall. 

4. Using the Source Monitor, mark an In point and an Out point for the source clip. 

5. In the Program Monitor, mark an In point and an Out point in the sequence. 

6. in the Source Monitor, do one of the following: 

  

• To perform an insert edit, click the Insert button  

• To perform an insert edit and shift clips in target tracks only, Alt-click (Windows) or 
Option-click (Mac OS) the Insert button . 

• To perform an overwrite edit, click the Overwrite button . 

 If the marked source and program durations differ, select an option when prompted: 

  

Change Clip Speed (Fit to Fill) 
Maintains the source clip’s In and Out points, but changes the clip’s speed so that its 
duration matches the duration determined by the sequence In and Out points. 

  

Trim Clip’s Head (Left Side) 
Automatically changes the source clip’s In point so that its duration matches the 
duration determined by the sequence In and Out points. 
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Trim Clip’s Tail (Right Side) 
Automatically changes the source clip’s Out point so that its duration matches the 
duration determined by the sequence In and Out points. 

  

Ignore Sequence In Point 
Disregards the sequence In point you set, and performs a three-point edit. 

  

Ignore Sequence Out Point 
Disregards the sequence Out point you set, and performs a three-point edit. 

Remove sequence In and Out points 

1. Make sure that the sequence is open in the Program Monitor. 

2. Choose Marker > Clear Sequence Marker, and then choose an option to clear the In 
point, the Out point, or both. 

  

Note: You can also clear an In or Out point by Alt-clicking (Windows) or Option-

clicking (Mac OS) the Set In button  or the Set Out button . 

 

 Shortcuts keys 

Here are some of the shortcut keys for trimming videos in Adobe Premiere Pro: 

Ripple Edit Tool (B) - selects the ripple edit tool, which allows you to trim a clip by dragging 

its edges and automatically adjust the clips that come after it. 

Rolling Edit Tool (N) - selects the rolling edit tool, which allows you to adjust the timing of 

an edit point between two clips by rolling the edit point. 

Trim Edit Tool (T) - selects the trim edit tool, which allows you to adjust the in and out 

points of a clip. 

Razor Tool (C) - selects the razor tool, which allows you to cut a clip into two parts at the 

point where the cursor is located 

Extend Selected Edit to Playhead (E) - extends the selected edit point to the location of the 

playhead. 

Trim Selected Edit to Playhead (Q) - trims the selected edit point to the location of the 

playhead. 
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Selection Tool (V) - selects the selection tool, which allows you to select clips and move 

them around in the timeline. 

Slip Edit Tool (Y) - selects the slip edit tool, which allows you to adjust the timing of a clip by 

moving its content within the clip's in and out points. 

Slide Edit Tool (U) - selects the slide edit tool, which allows you to move a clip in the 

timeline without changing its duration. 

Trim Mode (T) - toggles between trim mode and normal editing mode. In trim mode, you 

can use the trim edit tool to adjust the in and out points of a clip without affecting other 

clips in the timeline. 

Theoretical learning Activity  

✓  Ask trainees to demonstrate the function of video tracks and Audio Tracks in video 

Editing 

✓ Ask trainees to explain the process of trimming  a video clip in Adobe Premiere Pro. 

✓ Ask trainees to discuss the function of using shortcuts for inserting medi files on 

timeline. 

Practical learning Activity  

Here's a practical assessment about inserting media files on a timeline in Premiere Pro, 

along with a checklist for the task: 

Task: Create a short video using Premiere Pro that includes at least three media files (video, 

audio, or images) inserted on a timeline. 

Task: 

1. Open Premiere Pro and create a new project. 

2. Import at least three media files into your project. These can be video files, audio 

files, or images. 

3. Drag each media file onto the timeline in the order you want them to appear. 

4. Adjust the length of each clip on the timeline by dragging the edges of the clip or 

using the trimming tools. 

5. Use the effects panel to add any desired effects or adjustments to your clips, such as 

color correction, audio filters, or video transitions. 

6. Use the audio mixer panel to adjust the levels of your audio clips. 

7. Use the title tool to add text or captions to your video. 

8. Preview your video in the timeline and make any necessary adjustments to timing, 

effects, or audio levels. 
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9. Export your video using the export settings of your choice. 

10. Submit your final video and a brief write-up explaining your editing choices and the 

techniques you used to create your video. 

Checklist: 

• Did you import at least three media files into your project? 

• Did you drag each media file onto the timeline in the order you want them to 

appear? 

• Did you adjust the length of each clip on the timeline? 

• Did you use the effects panel to add any desired effects or adjustments to your clips? 

• Did you use the audio mixer panel to adjust the levels of your audio clips? 

• Did you use the title tool to add text or captions to your video? 

• Did you preview your video in the timeline and make any necessary adjustments to 

timing, effects, or audio levels? 

• Did you export your video using the export settings of your choice? 

• Did you submit your final video and a brief write-up explaining your editing choices 

and the techniques you used to create your video? 

 

 

Points to Remember (Take home message) 

 
✓ Do not forget how to drag the clip from the Project panel or Source Monitor 

to a Timeline panel . 
✓ Do not forget how to Drag video and audio only to the Timeline 
✓ When you add a clip to a sequence, it is important to assign which track or 

tracks it is to be edited to. 
 

 

Learning Outcome 2.2: Create rough-cut 

Duration: 10hrs 
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Learning outcome 2  objectives:  

By the end of the learning outcome, the trainees will be able to: 

✓ Creation of logic sequence referring to the script  
✓ Use of editing tools 
✓ Adding correctly B-rolls as done in video editing 
✓  Adding Intro and Outro templates  
✓ Adding background 

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software: 
Adobe Premiere Pro CC, 
Final Cut Pro, Adobe 
Premiere Clips, Sony Vegas 
Pro, Adobe After Effects, 
DaVinci Resolve, Red Giant, 
Video Copilot 

 

 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD 
Card 

Advance preparation: 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 

. RAW footages 

 

 
 
 

 

Indicative content2.2.1: Creation of logic sequence referring to the script 
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✓ Rhythm  

✓ Chronology  

✓ Continuity  

 

 

 Creation of logic sequence referring to the script 

✓ Rhythm sequence 
✓ Chronology sequence 
✓ Continuity sequence 

 
Creating a logic sequence for a script involves organizing the events in the story into a 
cohesive and logical order. Here are the general steps for creating a logic sequence: 
 

1. Read the script thoroughly and identify the major events and plot points. 

2. Determine the chronological order of events in the story. This may involve 

rearranging scenes or events from the original script to make the story flow more 

smoothly. 

3. Identify any flashbacks or flash-forwards in the story and decide where they should 

be placed in the sequence. 

4. Consider the pacing of the story and how it builds tension or resolves conflicts. 

Determine the order of events to create the most effective pacing. 

5. Create a storyboard or visual outline of the story, including any visual or special 

effects that may be needed. 

6. Identify any technical requirements, such as camera angles or lighting, that are 

necessary to execute the script effectively. 

7. Review the logic sequence to ensure that it is clear, logical, and engaging for the 

audience. 

 

 

Indicative content2.2.2:  Use of editing tools  

 
  
 
 
 
 

✓ Selection tool  

✓ Razor/Blade  

✓ Pen tool  

✓ Hand tool 

✓  Ripple tool 

✓ Zoom tool  

✓ Adding B-rolls  
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Use of editing tools 
 
Each icon in this panel represents a tool that performs a specific function, typically a type of 
edit in a sequence. When you select a tool, the pointer changes shape according to the 
selection. Understanding the shortcuts to these tools will save time editing 
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 Adding B-rolls 

B-roll is a term used to describe secondary footage, often used as cutaway footage, to 
provide context and visual interest to help tell your story. The term derives from the early 
days of Hollywood when they used to shoot on film. 
 

The term B-roll refers to accompanying footage intercut with a main shot in an interview 
or documentary. So, for example, your interview subject talking to camera may be your A-
roll. Any alternative footage, such as cutaways to surroundings or significant places, will be 
your B-roll 

Different video types  of B rolls differently and we’ll be looking at the top 5 ways you can 
use B rolls in your videos: 
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1. Atmospheric B rolls 

2. Undirected B Roll Footage 

3. Archival B Roll Footage 

4. Visual detail B Roll Footage 

5. Storytelling B Roll Footage 

Adding Intros and Outros templates 

What are the Key Components of Intros and Outros? 

✓ Animation 

✓ Sound 

✓ Where to Place Intros and Outros 

✓ While it might seem self-evident that intros should be placed at the very beginning 
of a video, and outros at the very end, this is not always the case. 

✓ More Tips on Creating Effective Intros and Outros 

✓ Keep It Short 

✓ Include a Call to Action 

✓ Follow Your Brand Guidelines 

✓ Use Logo Animation 

 

 

 

 

 

 

Indicative content2.2.3:  Adding background  
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A video background is merely a decoration. It creates atmosphere and enhances the look of 

the main object. In general, any color, pattern, or photo can be set as a video background. 

Adding a background to video could be a different task because there are two different 

video backgrounds. One is regular video background, the other is the green screen 

background. 
 
Chroma Key 

Chroma Key, also called a Green-screen key, is actually the process of replacing background 
color of a video with another desired background to make videos more appealing. Adobe 
Premiere Pro platform allows easy editing options for such type of changes with its great 
tool named as "Ultra Key". 
 
Use of background presets 

To use a background preset in Premiere Pro, simply select the clip or title you want to add 

the preset to, go to the Effects panel, and select the preset you want to apply. You can then 

adjust the settings of the preset to create the desired effect. 

 

 

 

 

 

 

Theoretical learning Activity  

 

✓ Ask trainees to brainstorm  about  rough cut in Adobe Premiere Pro. 

✓ Chroma key  

✓ Use of background presets 
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Practical learning Activity  

Assessment: Create a rough-cut for a short video project. 

Instructions: 

1. Download the provided video footage and import it into a new Premiere Pro project. 

2. Create a new sequence in the timeline panel that matches the settings of the 

footage. 

3. Add the footage to the sequence in the order you want it to appear, and trim each 

clip to the desired length. 

4. Add transitions between clips and adjust the timing of each clip as needed. 

5. Adjust the audio levels of each clip and add any necessary audio effects. 

6. Add a title or graphic to the rough-cut. 

7. Preview the rough-cut and make any necessary adjustments. 

8. Export the rough-cut to a file format that is compatible with YouTube. 

Checklist: 

1. Did the student import the video footage into Premiere Pro? 

2. Did the student create a new sequence that matches the settings of the footage? 

3. Did the student add the footage to the sequence in the correct order and trim each 

clip to the desired length? 

4. Did the student add transitions between clips and adjust the timing of each clip as 

needed? 

5. Did the student adjust the audio levels of each clip and add any necessary audio 

effects? 

6. Did the student add a title or graphic to the rough-cut? 

7. Did the student preview the rough-cut and make any necessary adjustments? 

8. Did the student export the rough-cut to a file format that is compatible with 

YouTube? 

9. Did the student organize and backup their project files? 

10. Did the student submit their completed rough-cut project on time? 

 

 

 

 

 

Points to Remember (Take home message) 
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✓ Remember that  rough cut is a timeline-based sequence of video and audio 
clips 

✓ Remember that Chroma Key, also called a Green-screen key,  
✓ Remember that B-roll is a term used to describe secondary footage,  
✓ Remember to Create  logic sequence referring to the script 

 

Learning Outcome 2.3:Apply transitions and effects 

 

Duration: 8hrs 

Learning outcome 3  objectives:  

By the end of the learning outcome, the trainees will be able to: 

✓ Activate effects panel 
✓ Select transitions/effects 
✓ Manage effects panel 

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software: 
Adobe Premiere Pro CC, 
Final Cut Pro, Adobe 
Premiere Clips, Sony Vegas 
Pro, Adobe After Effects, 
DaVinci Resolve, Red Giant, 
Video Copilot 

 

Books  

Internet   

Handout notes  

Drives  

 

Advance preparation: 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 
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. RAW footages 

 

 

 

 

Indicative content2.3.1:  Activation of effects panel  

 

• Activation of effects panel  

• Selection of transitions/effects  
✓ Audio/Video transitions 
✓  Audio/Video effects  

 
 

 

To activate the effects panel in Adobe Premiere Pro, you can follow these steps: 

1. Open Adobe Premiere Pro and create a new project or open an existing one. 

2. In the top menu bar, select Window > Effects to open the Effects panel. 

3. If you can't find the Effects panel in the workspace, you can also access it by 

selecting Window > Workspaces > Effects. 

Once the Effects panel is open, you can browse through the various categories of effects 

such as Video Effects, Audio Effects, and Transitions. You can also use the search bar to find 

a specific effect by name. To apply an effect, simply drag and drop it onto the clip in the 

timeline that you want to apply it to. From there, you can adjust the effect settings in the 

Effect Controls panel. 

What are transitions? 

A transition is an effect added between pieces of media to create an animated link between 

them. Transitions are used to move a scene from one shot to the next. Premiere Pro 

provides a list of transitions that you can apply to a sequence. A transition can be a subtle 

crossfade or a stylized effect. 

Different transitions available in Premiere Pro are: 

Audio transitions 

Video transitions 

VR transitions 

By default, placing one clip next to another in a Timeline panel results in a cut, where the 
last frame of one clip is followed by the first frame of the next. Transitions are usually placed 

https://helpx.adobe.com/premiere-pro/using/audio-transitions.html
https://helpx.adobe.com/premiere-pro/using/video-effects-transitions.html
https://helpx.adobe.com/premiere-pro/using/VRSupport.html
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on a cut line between shots. You can also apply a transition only to the beginning or end of a 
clip. 

Apply transitions between two clips 

To place a transition between two clips (centered on the cut line), the clips must be on the 
same track, with no space between them. 

 
Apply a single-sided transition 

Transitions are typically double-sided as they get applied to both clips. Single sided 
transitions are only applied on a single clip. This is useful when you don’t have a clip handle. 

Using single-sided transitions, you have more control over how clips transition. 

For example, you can create the effect of one clip departing using the Venetian 
Blinds transition, and the next clip fading in using Cross Dissolve. 

In a Timeline panel or the Effect Controls panel, a double-sided transition has a dark 
diagonal line through it, while a single-sided transition is split diagonally with one half dark 
and one half light. 
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Indicative Content2.3.2 Management of effects panel 

 

 

 

 

 

 

 

 

 

The Effect Controls panel lists all the effects that are applied to the currently selected clip. 
Fixed effects are included with every clip: the Motion, Opacity, and Time Remapping effects 
are listed in the Video Effects section and the Volume effect is listed in the Audio Effects 
section. The Volume effect is included only for audio clips or video clips with linked audio. 

Note: 

You can quickly optimize the interface for effects editing by selecting the Effects workspace. 
Choose Window > Workspace > Effects. 

✓ Motion  

✓ Opacity  

✓ Volume  

✓ Time remapping  

✓ Curves 

✓  Vignette 

✓  Colors 
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Effect Controls panel 

A. Sequence name B. Clip name C. Effects D. Show/Hide Timeline View button E. Filtering 
effects option  

By default, the timeline view is hidden, but you can show it by clicking the Show/Hide 
Timeline View button . Widen the Effect Controls panel, if necessary, to activate this 
button. 

You can click the triangle to expand an effect property to display the Value graph and 
Velocity graph. 

 

 

 

 

 

 

 

Theoretical learning Activity  
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Ask trainees to differentiate different types of transitions in Adobe Premiere Pro. 

Ask trainees to discuss the use of  transitions and how can be applied to a video clip  

Practical learning Activity  

Here is a practical assessment for transitions in Adobe Premiere Pro: 

Objective:  

To create a short video project using various transitions in Adobe Premiere Pro. 

Requirements: 

1. Adobe Premiere Pro software 

2. Raw footage, images, and music to create the video project 

3. Basic knowledge of Adobe Premiere Pro interface, tools, and features 

Instructions: 

1. Import the raw footage, images, and music into Adobe Premiere Pro. 

2. Create a new sequence and set the sequence settings according to the specifications of 

your project. 

3. Drag and drop the raw footage into the timeline. 

4. Edit the footage and arrange the clips according to the story or message you want to 

convey. 

5. Add transitions between the clips to create a smooth flow of the video. Use different 

types of transitions such as fade, dissolve, wipe, zoom, and slide to add visual interest. 

6. Adjust the duration of the transitions to make them fit the pace of the video. 

7. Add text, effects, and color correction to enhance the visual appeal of the video. 

8. Add music to the video and adjust the audio levels to balance the sound. 

9. Preview the video and make necessary adjustments to improve the quality. 

10. Export the final video in the desired format. 

Assessment checklist: 

1. Proper use of various transitions to create a smooth flow of the video. 

2. Effective arrangement of the clips and use of text, effects, and color correction to 

enhance the visual appeal of the video. 

3. Appropriate use of music and audio levels to balance the sound. 

4. Overall creativity and technical proficiency in using Adobe Premiere Pro to create a 

high-quality video project. 

 

Points to Remember (Take home message) 
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• Placing one clip next to another in a Timeline panel 

• The Effect Controls panel lists all the effects that are applied to the 
currently selected clip. 

 

 

Learning outcome 2.4 : Manage titles 

Duration: 6hrs 

Learning outcome 4  objectives:  

By the end of the learning outcome, the trainees will be able to: 

✓ Create titles  
✓ Import/Export titles and add titles on timeline  

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software: 
Adobe Premiere Pro CC, 
Final Cut Pro, Adobe 
Premiere Clips, Sony Vegas 
Pro, Adobe After Effects, 
DaVinci Resolve, Red Giant, 
Video Copilot 

 

 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD 
Card 

Advance preparation: 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 
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. RAW footages 

 

 

 

 

 

Indicative content2.4.1: Create titles 

✓ Fonts selection  
✓ Colors  

 Background color  
 Foreground color S 
 troke  

 

 

Create titles 

Creating titles in Adobe Premiere Pro is a straightforward process that allows you to 

customize the font, size, color, alignment, and other text attributes of your title. With the 

Effects Control panel, you can also add animations and other effects to your title. Using the 

Essential Graphics panel, you can save your title as a template for future use. 

To create titles in Adobe Premiere Pro, follow these steps: 

1. Open Adobe Premiere Pro and create a new sequence. 

2. Go to the "Graphics" workspace by selecting it from the top menu bar. 

3. Click on the "Text" tool in the toolbar on the left-hand side of the screen. 

4. Click and drag on the Program Monitor to create a text box where you want your title to 

appear. 

5. Type in your text and use the Character and Paragraph panels to customize the font, 

size, color, alignment, and other text attributes. 

6. Use the Effects Control panel to add animations and other effects to your title. For 

example, you can use the "Position" property to animate the title moving across the 

screen or the "Scale" property to make it larger or smaller. 

7. Use the Essential Graphics panel to save your title as a template, so you can easily use it 

again in future projects. 

8. Drag and drop your title from the Graphics panel onto the timeline where you want it to 

appear in your sequence. 

9. Adjust the timing of your title by dragging the edges of the clip on the timeline. 

10. Preview your video to make sure your title appears as desired. 
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Creating your title 

  

  

 

Working with templates  

Working with templates in Adobe Premiere Pro allows you to easily add professional-looking 

graphics and animations to your videos. By customizing the templates, you can create a 

unique look and feel that matches your brand or message. The Essential Graphics panel 

provides a simple interface for modifying the templates, and saving them as new templates 

allows you to reuse them in future projects. 

Working with templates in Adobe Premiere Pro can save time and help you create high-

quality videos with professional-looking graphics and animations. Here are the steps to work 

with templates in Adobe Premiere Pro: 

1. Open Adobe Premiere Pro and go to the "Graphics" workspace. 

2. Choose "Browse" from the Essential Graphics panel, located in the bottom right corner 

of the screen. 

3. Browse the selection of templates available from Adobe Stock, or search for a specific 

type of template. 

4. Preview the templates to find the one that best suits your needs. 

5. Click "Open" to download the template to your computer. 

6. Drag and drop the template onto the timeline where you want it to appear in your 

video. 

7. Customize the template by double-clicking on it in the timeline. This will open the 

Essential Graphics panel, where you can modify the text, color, and other attributes of 

the template. 

8. Save the modified template as a new template in the Essential Graphics panel for 

future use. 
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To import a title as a template: 

• Open your title 

• Choose Title > Templates 

• In the Templates window, click on the top-right menu 

• Choose > Import Current Title as Template 

 

To load a template, simply choose from the list of User Templates on the left side and 

choose OK. In the future, you can also choose Title > New Title > Based on Template. 
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Indicative content 2.4.2: Import/Export titles Addition of titles on timeline 

 

 

 

 

 

 

Importing and exporting a title 

It’s also handy to be able to import a title from a different project. You can do that by simply 

importing it like any other media. Just make sure to export the titles you’d like to use: 

Select the title in the Project Window and choose File > Export > Title 

Once you’ve gotten a grasp of this tool in Premiere, you’ll be one step closer to being a full-

service editor, and a full-service editor is someone who gets consistent work. Have 

questions? Just let us know in the comments! 

Title duration 

In Adobe Premiere Pro, the process of adjusting the duration of a title is simple. Here are 

the steps: 

1. Locate the title in the timeline and click on it to select it. 

2. Position the cursor over the end of the title clip until the cursor changes to a bracket 

with an arrow pointing in both directions. 

Click and drag the bracket to the left or right to adjust the duration of the title clip. 

Alternatively, you can adjust the duration of the title clip by entering a specific value in the 

"Duration" field in the Title Properties panel. To access this panel, select the title clip in the 

timeline and go to the Essential Graphics panel. From there, click on the Edit button to open 

the Title Properties panel. 

Theoretical learning Activity  

1. Ask trainees to brainstorm about titles creation in Adobe Premiere Pro. 

Practical learning Activity  

Here's a practical assessment for creating titles in Adobe Premiere Pro: 

✓ Title duration  

✓ Add effects/transitions 
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Task:  

Create a title for a video project in Adobe Premiere Pro. 

 

 

Requirements: 

1. The title should include the name of the video project. 

2. The text should be centered in the middle of the screen. 

3. The font should be Arial, with a font size of 48 and a white color. 

4. The background of the title should be transparent. 

5. The title should appear for 5 seconds at the beginning of the video. 

Steps: 

1. Open Adobe Premiere Pro and create a new project. 

2. Go to the "Graphics" workspace. 

3. Click on the "Text" tool in the toolbar on the left-hand side of the screen. 

4. Click and drag on the Program Monitor to create a text box where you want your 

title to appear. 

5. Type in the name of the video project. 

6. Use the Character panel to select Arial font, 48 font size, and white color. 

7. Use the Align and Transform tools to center the text box in the middle of the screen. 

8. Use the Effects Control panel to adjust the opacity of the text box to 0% to make the 

background transparent. 

9. Use the Essential Graphics panel to save the title as a template. 

10. Drag and drop the title from the Graphics panel onto the timeline at the beginning of 

the video. 

11. Adjust the timing of the title to appear for 5 seconds. 

12. Preview the video to ensure the title appears as desired. 

Assessment Criteria: 

1. The title includes the name of the video project. 

2. The text is cantered in the middle of the screen. 

3. The font is Arial, with a font size of 48 and a white color. 

4. The background of the title is transparent. 

5. The title appears for 5 seconds at the beginning of the video. 

  

Points to Remember (Take home message) 

 



48 
 

 

• If you’re working with titles on a regular basis, it can be useful to create 
templates to save some time. 

• It’s also handy to be able to import a title from a different project. 
Title duration in adobe premiere proitle duration Add effects/transitions 

 

Learning outcome2.5: Perform clips synchronization and multicamera editing techniques 

 

Duration: 8hrs 

Learning outcome 5  objectives:  

By the end of the learning outcome, the trainees will be able to: 

✓ Synchronize clips  
✓ Edit Multi cameras 

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software: 
Adobe Premiere Pro CC, 
Final Cut Pro, Adobe 
Premiere Clips, Sony Vegas 
Pro, Adobe After Effects, 
DaVinci Resolve, Red Giant, 
Video Copilot 

 

 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD 
Card 

Advance preparation: 

. Use Pre-Prepared Illustrations 
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. Downloaded editing tutorials. 

. RAW footages 

 

 

 

 

 

 

 

 

 

 

 

 

 

Indicative content 2.5.1: Clips synchronization  

✓ Choosing the clips for synchronization  
✓ Management of the synchronization window  

 

 

Whether you’re creating a narrative film, promotional video, or vlog, audio will always be an 

area for improvement. Recording your audio separately from your video clips can result in 

better sound, especially when there is dialogue. As a result, you’ll need to synchronize your 

audio and video clips before you can edit them. 

What is Premiere Pro Audio Synchronization? 

The first thing to note is, if you have multiple camera angles, each with an audio track of its 
own, it is much easier to use the Premiere Multicam tools; check out this handy guide. The 
method we’re going to show you today offers a super quick and easy solution to matching 
multiple audio tracks to a single video clip. 
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Premiere Pro audio synchronization tools offer 3 ways to sync your sound to your video: 
start and end of the clip, as well as audio. In most situations, you will likely want to use the 
audio option, where Premiere reads all your audio tracks and uses the sound waves to 
match them. 

For the synchronization to work, you will need to have an audio layer already attached to 
your video clip. This will be the audio recorded by your camera. So, even if you don’t intend 
on using the onboard audio from your camera, make sure it is still being recorded. 

 

Indicative content 2.5.2: Multicamera editing 

 

 

 

 

Multicamera editing in Premiere Pro 

Create a Multicam Sequence 

1. Import your footage into your project. 
2. In the Project Browser, select the clips that you want to use in the Multicam 

sequence (hold Cmd or Ctrl while selecting multiple clips). 
3. Right-click one of the selected clips and click Create Multi-Camera Source Sequence. 

✓ Creation of multicamera clips  

 Organization of clips within each angle  

 Synchronization the angles using common sync points  

• Editing and switching of camera angles 
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4. Name the project; we will use Intro or Question 1 (choose something that references 
which source clips are being used). 

5. Choose your Synchronize Point settings. It’s most likely that you’ll need to use 
the Audio option; leave the Track Channel at Mix Down. 

6. Set the Sequence Preset > Automatic. 
7. Unless you have renamed your clips during selection, check the Enumerate 

Cameras box. Click OK, and you’re all set up. 

Set Up the Sequence 

1. Find your new sequence in the Project browser, right-click and choose New 
Sequence from Clip. 
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2. You’ll now have one clip in your timeline, with a single audio track. 

 

3. Go to your Button editor, then select the multi-camera editing icon, Multi-Camera 
View. 

4. Drag the icon and drop it on your button bar. 

5. Click OK to close the Button editor, then click on the multi-camera icon in the button 
bar to open the multi-camera view. 

 

 

Edit & Switch Camera Angles 

The largest of the windows in the Program Monitor is your Active camera. This displays the 
main video sequence. The smaller windows display the individual clips that make up the 
multi-camera clip. 
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There are 2 ways to edit between camera angles: 

1. Play through the sequence until you reach a point that you would like the camera 
angles to change, click on the camera angle in the Program Monitor. Premiere Pro 
will add an edit, switching to that angle. 

2. Play through the sequence until you reach a point that you would like the camera 
angles to change. Using your keyboard, press the number allocated to the camera 
angle. 

To reorganize your camera angles, select Edit Cameras. From here, you can easily drag-and-
drop the clips to change the order. If you want to disable an angle you no longer want to use 
just deselect it by clicking on the checkbox. If you have more than 4 angles to manage, you 
can organize and select cameras across multiple pages, and navigate between them as 
needed. 

With practice, multi-camera editing can be quite a quick process, as you can make cuts while 
the video is playing. 

 

 

 

Theoretical learning Activity  

Ask trainees to discuss how to synchronize clips  in Adobe Premiere Pro 

Ask trainees how to perform multicameras editing in Adobe Premiere Pro 
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Practical learning Activity  

Practical Assessment: 

 Clips Synchronization and Multicamera Editing in Adobe Premiere Pro 

In this practical assessment, you will be given a set of audio and video clips that need to be 

synchronized and edited using multicamera editing techniques in Adobe Premiere Pro. 

Instructions: 

1. Download the audio and video clips provided in the link. 

2. Import all the audio and video clips into the project panel in Adobe Premiere Pro. 

3. Select the audio and video clips that you want to synchronize. 

4. Right-click on the selected clips and choose "Synchronize" from the drop-down 

menu. 

5. In the Synchronize dialog box, choose the "Audio" option and click "OK." 

6. Premiere Pro will create a new clip that contains the synchronized audio and video 

clips. 

7. Drag and drop the synchronized clip to the timeline. 

8. Repeat steps 3-7 for any additional audio and video clips that need to be 

synchronized. 

9. Create a new sequence by going to "File" > "New" > "Sequence." 

10. In the New Sequence dialog box, choose the appropriate settings for your video. 

11. Drag and drop one camera angle onto the timeline. 

12. Right-click on the clip and choose "Multi-Camera" > "Enable." 

13. Click on the "+ Camera" button in the Program Monitor to add the other camera 

angles. 

14. Use the "Cut" button in the Program Monitor to switch between camera angles 

while previewing the video. 

15. Make any necessary edits to the video using the Razor tool or other editing 

techniques. 

16. Add transitions, effects, and titles as needed to enhance the video. 

17. When finished editing, go to "File" > "Export" > "Media" to export the final video. 

18. Submit the final exported video along with the Adobe Premiere Pro project file. 

Assessment Criteria: 

• All audio and video clips are synchronized properly. 

• The multicamera editing technique is used to switch between camera angles smoothly. 

• Any necessary edits are made to the video using the Razor tool or other editing 

techniques. 

• Transitions, effects, and titles are used effectively to enhance the video. 
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• The final exported video is of high quality and meets the required specifications. 

Checklist: 

All audio and video clips are synchronized properly. 

The multicamera editing technique is used to switch between camera angles smoothly. 

Any necessary edits are made to the video using the Razor tool or other editing 

techniques. 

Transitions, effects, and titles are used effectively to enhance the video. 

The final exported video is of high quality and meets the required specifications. 

The Adobe Premiere Pro project file is submitted along with the final exported video. 

 

Points to Remember (Take home message) 

 

• if you have multiple camera angles, each with an audio track of its own, it is 
much easier to use the Premiere Multicam tools. 

• For the synchronization to work, you will need to have an audio layer 
already attached to your video clip. 
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Learning outcome2.6:  Manipulate clips speed and stabilization 

Duration: 8hrs 

Learning outcome 6  objectives:  

By the end of the learning outcome, the trainees will be able to: 

✓ Create titles  
✓ Import/Export titles and add titles on timeline  

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software: 
Adobe Premiere Pro CC, 
Final Cut Pro, Adobe 
Premiere Clips, Sony Vegas 
Pro, Adobe After Effects, 
DaVinci Resolve, Red Giant, 
Video Copilot 

 

 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD 
Card 

Advance preparation: 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 

. RAW footages 
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Indicative content2.6.1: Creation of speed changes on clips  

✓ Fast/Slow the clips 
✓ Animation and key frames 

 Adding, navigating, and setting key frames  
 Moving and copying key frames 
 Controlling effect changes using key frame interpolation 

 

 

Manipulating clip speed and stabilization are two important techniques in video editing that 

can be achieved using Adobe Premiere Pro. Here's an overview of both techniques: 

Clip Speed Manipulation: 

1. Drag the video clip to the timeline. 

2. Right-click the clip and select "Speed/Duration" option from the context menu. 

3. A new window will pop up, which displays the speed and duration of the clip. 

4. You can change the speed of the clip by increasing or decreasing the percentage 

value. 

5. To make the clip slower, reduce the percentage value to less than 100%, and to 

make it faster, increase the percentage value to more than 100%. 

You can also select "Retime" option to apply different speed changes to different parts of 

the clip. 
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Indicative content 2.6.2: Stabilization of shaky footages 

 

 

 

 

Adobe Premiere Pro provides several options for stabilizing shaky footage. Here are the 

steps to stabilize footage in Adobe Premiere Pro: 

1. Select the shaky clip in the timeline that you want to stabilize. 

2. Go to the "Effects" panel and search for "Warp Stabilizer." Drag and drop the effect 

onto the clip. 

3. Once applied, Premiere Pro will analyze the footage and apply stabilization. 

4. You can adjust the settings in the "Effect Controls" panel to customize the 

stabilization effect. 

Alternatively, you can use the "Transform" effect to stabilize footage manually. Here are the 

steps: 

1. Select the shaky clip in the timeline that you want to stabilize. 

2. Go to the "Effects" panel and search for "Transform." Drag and drop the effect onto 

the clip. 

3. In the "Effect Controls" panel, adjust the "Position" and "Scale" parameters to 

manually stabilize the footage. 

4. You can also keyframe the "Position" and "Scale" parameters to adjust the 

stabilization over time. 

 

Yes, there are several third-party software and plug-ins that you can use to stabilize shaky 

footage in Adobe Premiere Pro. Here are a few popular options: 

1. Mercalli V5: This plug-in offers advanced stabilization options for Premiere Pro, 

including 3D stabilization, rolling shutter correction, and motion smoothing. 

2. ReelSteady: This plug-in is specifically designed for stabilizing footage shot on a 

GoPro or similar action camera. It uses advanced algorithms to eliminate jitters and 

vibrations from footage. 

3. Mocha Pro: This software includes a module called "Stabilize" that can be used to 

stabilize footage in Premiere Pro. It offers advanced options like perspective and 

rotation stabilization. 

4. After Effects: While not a third-party plug-in, After Effects is a powerful motion 

graphics and visual effects software that can be used to stabilize footage. You can 

import your Premiere Pro project into After Effects, apply stabilization, and then 

export the stabilized footage back to Premiere Pro. 

✓ Stabilization with editing software presets 

 Warp stabilizer  

 Activation of stabilization 

Stabilization with third party software or plug-in 
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 Theoretical learning Activity  

✓ Ask trainees discuss about clip speed manipulation in adobe premiere pro. 

  

Practical learning Activity  

Practical Assessment: Manipulating Clip Speed and Stabilization in Adobe Premiere Pro 

Instructions: 

1. Download the video clip provided in the link. 

2. Import the video clip into the project panel in Adobe Premiere Pro. 

3. Drag the video clip to the timeline. 

4. Use the clip speed manipulation technique to make the first 5 seconds of the clip 

play at 50% speed. 

5. Use the same technique to make the next 5 seconds of the clip play at 150% speed. 

6. Apply stabilization to the entire clip using the stabilization technique outlined above. 

7. Fine-tune the stabilization effect using the "Smoothness" and "Crop Less" settings. 

8. Make any necessary edits to the video using the Razor tool or other editing 

techniques. 

9. Add transitions, effects, and titles as needed to enhance the video. 

10. When finished editing, go to "File" > "Export" > "Media" to export the final video. 

11. Submit the final exported video along with the Adobe Premiere Pro project file. 

Checklist: 

The clip speed manipulation technique is used to make the first 5 seconds play at 50% 

speed and the next 5 seconds play at 150% speed. 

The stabilization technique is used to stabilize the entire clip. 

The "Smoothness" and "Crop Less" settings are adjusted to fine-tune the stabilization 

effect. 



60 
 

Any necessary edits are made to the video using the Razor tool or other editing 

techniques. 

Transitions, effects, and titles are used effectively to enhance the video. 

The final exported video is of high quality and meets the required specifications. 

The Adobe Premiere Pro project file is submitted along with the final exported video. 

Points to Remember (Take home message) 

 

Here are some key points to remember about manipulating clip speed and 
stabilization in video editing: 

✓ Clip speed manipulation can be used to create slow-motion or time-lapse 
effects, or to fit footage into a specific time frame. 

✓ Stabilization can be used to reduce camera shake and jitter, and create a 
smoother, more professional-looking video. 

✓ Clip speed manipulation and stabilization can be used together to create a 
polished final video. 

✓ In Adobe Premiere Pro, clip speed can be adjusted by right-clicking on the 
clip in the timeline and selecting "Speed/Duration." 

✓ In Adobe Premiere Pro, stabilization can be applied by selecting the clip in 
the timeline, opening the "Effects Control" panel, selecting "Motion," and 
choosing "Stabilize." 

✓ The "Smoothness" and "Crop Less" settings in the Effects Control panel can 
be adjusted to fine-tune the stabilization effect. 

✓ It's important to be cautious when manipulating clip speed and 
stabilization, as overuse can create a jarring or unnatural effect. Use these 
techniques sparingly and with intention. 
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Learning outcome 7.1: Apply color correction and color grading techniques 

Duration: 6hrs 

Learning outcome 7  objectives:  

By the end of the learning outcome, the trainees will be able to: 

✓ Create titles  
✓ Import/Export titles and add titles on timeline  

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software: 
Adobe Premiere Pro CC, 
Final Cut Pro, Adobe 
Premiere Clips, Sony Vegas 
Pro, Adobe After Effects, 
DaVinci Resolve, Red Giant, 
Video Copilot 

 

 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD 
Card 

Advance preparation: 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 

. RAW footages 
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Indicative content 2.7.1:  Management of white balance  

✓ Temperature 
✓ Tint  

 

 

In the management of white balance, temperature and tint are two different parameters 

that are used to adjust the color balance of an image. 

Temperature is measured in Kelvin (K) and adjusts the overall warmth or coolness of an 

image. The higher the temperature, the warmer the image will appear, while lower 

temperatures will create a cooler image. For example, indoor lighting tends to have a 

warmer color temperature than outdoor lighting. 

Tint, on the other hand, adjusts the green or magenta color cast in the image. Positive 

values add magenta to the image, while negative values add green. This is useful for 

removing any unwanted color casts that might be present in the image. 

When adjusting white balance, it's important to adjust both temperature and tint to achieve 

the desired result. Start by adjusting the temperature to get the overall color balance close 

to neutral, and then adjust the tint to remove any remaining color casts. You can also use 

the eyedropper tool to select a neutral area in the image, which will automatically adjust 

the temperature and tint based on that selection. 

 

 

Indicative content 2.7.2: Manipulation of color tone  

 

 

 

✓ Exposure  

✓ Contrast  

✓ Highlights  

✓ Shadows  

✓ Whites 

✓ Blacks 
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Exposure, contrast, highlights, shadows, whites, and blacks are all important aspects of color 

correction in video editing. 

Exposure refers to the brightness of an image. Increasing the exposure will make the image 

brighter, while decreasing it will make the image darker. 

Contrast refers to the difference between the darkest and brightest areas of the image. 

Increasing contrast will make the dark areas darker and the bright areas brighter, while 

decreasing contrast will make the image look more flat. 

Highlights are the brightest areas of the image, while shadows are the darkest areas. 

Adjusting the highlights and shadows can help to balance the exposure and create a more 

visually appealing image. 

Whites and blacks refer to the purest white and darkest black areas of the image. Adjusting 

these values can help to create a more balanced exposure and ensure that the white and 

black areas of the image are not over- or under-exposed. 

When adjusting exposure, contrast, highlights, shadows, whites, and blacks, it's important to 

monitor the changes in the image using the scopes panel. The waveform monitor and 

vectorscope can help to ensure that the exposure and color balance are consistent 

throughout the image. 

It's also important to consider the overall mood and style of the video when making these 

adjustments. For example, a high-contrast look might be appropriate for a dramatic scene, 

while a low-contrast look might be better suited for a more subdued scene. 

In Premiere Pro, these adjustments can be made in the "Lumetri Color" panel in the "Color" 

workspace. The "Basic Correction" tab includes options for adjusting exposure, contrast, 

highlights, shadows, whites, and blacks, while the "Color Wheels & Match" tab can be used 

to adjust the tonal balance of the image. 
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Indicative content 2.7.3: Manipulation of color wheels 

 

 

 

 

Shadows are the darkest areas of the image, while highlights are the brightest areas. 

Adjusting the shadows can help to reveal more detail in the darker areas of the image, while 

adjusting the highlights can help to prevent overexposure and reveal detail in the brightest 

areas. 

Midtones are the areas of the image between the shadows and highlights. Adjusting the 

midtones can help to balance the overall exposure and create a more natural-looking image. 

In Premiere Pro, these adjustments can be made using the "Color Wheels & Match" tab in 

the "Lumetri Color" panel. The "Shadows," "Midtones," and "Highlights" wheels allow you to 

adjust the tonal balance of specific ranges. 

To adjust the shadows, drag the "Shadows" wheel towards the right to brighten the 

shadows or towards the left to darken them. To adjust the highlights, drag the "Highlights" 

wheel towards the left to bring down the brightness or towards the right to increase it. To 

adjust the midtones, drag the "Midtones" wheel towards the right to make the midtones 

brighter or towards the left to make them darker. 

 

 

 

 

 

 

 

 

 

✓ Shadows 

✓ Midtones  

✓ Highlights 
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Indicative content 2.7.4:Manipulation of Color curves 

 

 

RGB curves and Hue Saturation curves are powerful tools in Premiere Pro's Lumetri Color 

panel that allow you to fine-tune the color and tonal balance of your video footage. 

RGB curves allow you to adjust the red, green, and blue channels of your footage separately. 

This is useful when you want to make subtle adjustments to the color balance or contrast of 

your footage. For example, you might want to boost the blue channel slightly to make the 

sky look more vibrant or darken the red channel to make skin tones look more natural. 

To use the RGB curves in Premiere Pro, open the "Color Wheels & Match" tab in the Lumetri 

Color panel and select "Curves." You can then adjust the curves for each color channel by 

clicking and dragging on the curve. To add a point on the curve, simply click on it. To delete 

a point, right-click on it and select "Delete." 

Hue Saturation curves allow you to adjust the hue and saturation of specific colors in your 

footage. This is useful when you want to make specific colors more or less prominent in your 

footage. For example, you might want to boost the saturation of green foliage in a 

landscape shot or desaturate the blue channel to create a more moody atmosphere. 

To use the Hue Saturation curves in Premiere Pro, open the "Hue Saturation Curves" tab in 

the Lumetri Color panel. You can then select a color range from the drop-down menu and 

adjust the curve to increase or decrease the saturation or shift the hue of that color range. 

Both RGB curves and Hue Saturation curves can be used in combination with other Lumetri 

Color adjustments, such as exposure, contrast, shadows, and highlights, to create a finely 

tuned and visually appealing image. It's important to monitor the changes in the image 

using the scopes panel to ensure that the overall color and tonal balance is consistent 

throughout the image. 

 

 

 

 

✓ RGB curves  

✓ Hue Saturation curves 
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Indicative content 2.7.5: Application of vignette 

 

 

 

Amount management, Midpoint management , Roundness management and Feather 

management in adobe premiere pro 

Amount, midpoint, roundness, and feather management are all aspects of Premiere Pro's 

masking tools that allow you to create precise and refined masks for your video footage. 

Amount management refers to the overall opacity of the mask. You can adjust the amount 

to make the mask more or less visible. This is useful when you want to fine-tune the mask to 

blend in with the surrounding footage. 

Midpoint management allows you to adjust the position of the midpoint of the mask. This 

can be useful when you want to adjust the falloff of the mask or change the overall shape of 

the mask. 

Roundness management allows you to adjust the roundness of the mask. You can make the 

mask more or less rounded, which is useful when you want to create a more natural-looking 

mask for objects with curved edges. 

Feather management allows you to adjust the softness of the edges of the mask. Adding 

feather to the edges of the mask can help to blend it more naturally with the surrounding 

footage and make it less noticeable. You can adjust the feather amount and the feather 

shape to create a more natural-looking mask. 

To access the masking tools in Premiere Pro, select the clip that you want to mask in the 

timeline and open the "Effects Controls" panel. Expand the "Opacity" section to reveal the 

masking options. You can then use the pen tool or any of the other masking tools to create 

and refine your mask. 

Using a combination of amount, midpoint, roundness, and feather management, you can 

create precise and natural-looking masks for your video footage in Premiere Pro. 

✓ Amount management  

✓ Midpoint management 

✓ Roundness management  

✓ Feather management 
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Theoretical learning Activity 

✓ Ask trainees to discuss about the difference between color correction and color 

grading 

Practical learning Activity 

For this practical assessment, you will be given a short video clip that requires color 

correction and color grading. Your task is to use Adobe Premiere Pro's Lumetri Color panel 

to correct the color balance and tone of the footage, and then apply a creative color grade 

to enhance the mood and style of the video. 

Instructions: 

1. Download the provided video clip and import it into Adobe Premiere Pro. 

2. Open the Lumetri Color panel and use the "Basic Correction" tab to adjust the 

exposure, contrast, shadows, highlights, whites, and blacks of the footage. Use the 

scopes panel to ensure that the color balance and tonal balance are consistent 

throughout the clip. 

3. Use the "Curves" tab to adjust the RGB curves for each color channel to fine-tune the 

color balance of the footage. 

4. Use the "Hue Saturation Curves" tab to adjust the hue and saturation of specific 

color ranges to make certain colors more or less prominent in the footage. 

5. Once you are satisfied with the color correction, move on to applying a creative color 

grade to the footage. 

6. Use the "Creative" tab in the Lumetri Color panel to apply a creative LUT or adjust 

the color temperature, tint, and saturation to achieve the desired look and feel of 

the footage. Experiment with different options until you find a color grade that 

enhances the mood and style of the video. 

7. Finally, export the footage and submit it for evaluation. 

Evaluation: 

Your work will be evaluated based on the following criteria: 

1. Color Correction: The color balance and tonal balance of the footage should be 

consistent and natural-looking. The exposure, contrast, shadows, highlights, whites, 

and blacks should be adjusted to achieve a well-exposed and well-balanced image. 

2. Color Grading: The creative color grade should enhance the mood and style of the 

video. The color temperature, tint, and saturation should be adjusted to achieve the 

desired look and feel of the footage. 

3. Technique: Your use of Adobe Premiere Pro's Lumetri Color panel should 

demonstrate a good understanding of color correction and color grading principles. 
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You should use a combination of tools, such as basic correction, curves, and hue 

saturation curves, to achieve a refined and professional-looking result. 

4. Creativity: Your color grade should demonstrate creativity and an ability to enhance 

the mood and style of the footage. Your color choices should be appropriate for the 

subject matter and style of the video. 

 

 

Points to Remember (Take home message) 

 

Here are some key points to remember about applying color correction and color grading 
techniques in Adobe Premiere Pro: 

✓ Use the Lumetri Color panel to apply color correction and grading to your footage. 
This panel offers a variety of tools for adjusting the color balance, exposure, and 
saturation of your footage. 

✓ Use the Scopes panel to analyze the color balance of your footage and make 
adjustments as needed. The Scopes panel offers waveform, vectorscope, and RGB 
parade scopes for analyzing different aspects of the color balance. 

✓ Use adjustment layers to apply color correction and grading effects to multiple clips 
at once. This can save time and ensure consistency across multiple clips. 

✓ Use masks to apply color correction or grading effects to specific areas of your 
footage, such as a person's face or a particular object in the scene. 

✓ Use LUTs or presets to apply a consistent color grading across all footage. Premiere 
Pro offers a variety of built-in LUTs and the ability to import custom LUTs. 

✓ Experiment with different color grading techniques and apply them to different 
sections of your footage to achieve the desired look and feel. 

✓ Avoid overdoing the color correction and grading - it should enhance the visual 
quality of the footage, not distract from it. 

✓ Use the Color Match tool to match the color balance of different shots in your project 
for consistency. 

✓ Always preview the final result and make any necessary adjustments to ensure that 
the color correction and grading looks natural and enhances the visual quality of the 
footage. 

✓ Use the Lumetri Scopes panel to ensure that your footage conforms to broadcast 
standards, if necessary. This can ensure that your footage looks good on a variety of 
devices and platforms. 
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Learning Unit 2 formative assessment 

Written assessment 

1. What is trim video? Answer: Trimming a video involves removing unwanted sections 

from the beginning, middle, or end of a video clip. 

2. Can you trim a video using Adobe Premiere Pro? Answer: Yes, Adobe Premiere Pro 

offers a variety of tools for trimming video clips, including the razor tool and the trim 

tool. 

3. Does trimming a video change the resolution of the video? Answer: No, trimming a 

video does not change the resolution of the video. 

4. Is it possible to trim a video without losing any frames? Answer: Yes, it is possible to 

trim a video without losing any frames as long as you are only removing whole 

frames from the beginning or end of the clip. 

5. Can you trim a video using a free video editing software? Answer: Yes, there are 

several free video editing software options that allow you to trim video clips, 

including DaVinci Resolve, OpenShot, and Shotcut. 

6. Can you trim a video in real-time while playing it? Answer: No, it is not possible to 

trim a video in real-time while playing it. You must pause the video and use editing 

tools to trim the clip. 

7. What are some common keyboard shortcuts used to trim a video? Answer: Some 

common keyboard shortcuts for trimming video clips include "I" and "O" to mark the 

in and out points, "R" to toggle between the razor tool and the selection tool, and 

"Ctrl/Command + K" to cut a clip. 

8. Can you trim a video and save the trimmed portion as a separate file? Answer: Yes, it 

is possible to trim a video and save the trimmed portion as a separate file using a 

video editing software. 

9. Is it possible to undo a video trim if you made a mistake? Answer: Yes, most video 

editing software allows you to undo a video trim if you made a mistake. 

10. Can you trim a video on a mobile device using a video editing app? Answer: Yes, 

there are many video editing apps for mobile devices that allow you to trim video 

clips, including Adobe Premiere Rush, iMovie, and PowerDirector. 

 
True or false questions and answers about trim video 

1. Trimming a video involves removing unwanted sections from the beginning, middle, 

or end of a video clip. Answer: True. 

2. Trimming a video changes the resolution of the video. Answer: False. 

3. It is not possible to trim a video without losing any frames. Answer: False. 

4. Adobe Premiere Pro does not offer any tools for trimming video clips. Answer: False. 
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5. Free video editing software options do not allow you to trim video clips. Answer: 

False. 

6. It is possible to trim a video in real-time while playing it. Answer: False. 

7. There are no common keyboard shortcuts for trimming video clips. Answer: False. 

8. It is not possible to save the trimmed portion of a video clip as a separate file. 

Answer: False. 

9. You cannot undo a video trim if you made a mistake. Answer: False. 

10. You cannot trim a video on a mobile device using a video editing app. Answer: False. 

 
Multiple questions and answers about trim video 

1. What is the purpose of trimming a video? Answer: Trimming a video allows you to 

remove unwanted sections from the beginning, middle, or end of a video clip. 

2. What is the difference between trimming and cutting a video? Answer: Trimming a 

video involves removing unwanted sections from the beginning, middle, or end of a 

clip, while cutting a video involves splitting a clip into two or more separate parts. 

3. What tools can you use to trim a video clip in Adobe Premiere Pro? Answer: Adobe 

Premiere Pro offers several tools for trimming video clips, including the razor tool, 

the selection tool, and the trim tool. 

4. Is it possible to trim a video clip without changing the overall length of the clip? 

Answer: No, trimming a video clip will change the overall length of the clip by 

removing sections of it. 

5. Can you undo a trim on a video clip in Adobe Premiere Pro? Answer: Yes, you can 

undo a trim on a video clip in Adobe Premiere Pro by using the "Undo" command or 

pressing "Ctrl/Cmd + Z." 

6. What is the purpose of the in and out points when trimming a video clip? Answer: In 

and out points are used to mark the beginning and end of the section of the video 

clip that you want to keep when trimming. 

7. How can you ensure that the trimmed section of a video clip is seamless? Answer: 

You can ensure that the trimmed section of a video clip is seamless by using the 

ripple edit tool or by using a cross dissolve transition. 

8. Can you trim a video clip in iMovie on a mobile device? Answer: Yes, you can trim a 

video clip in iMovie on a mobile device by selecting the clip in the timeline and 

dragging the edges to the desired length. 

9. Can you trim a video clip using the YouTube video editor? Answer: Yes, you can trim 

a video clip using the YouTube video editor by selecting the video in the editor and 

using the trim function to remove unwanted sections. 

10. Is it possible to trim a video clip without losing any quality? Answer: Yes, it is possible 

to trim a video clip without losing any quality as long as you are only removing whole 

frames from the beginning or end of the clip. 
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Practical assessment 

Assessment tools: 

• Video editing software such as Adobe Premiere Pro or iMovie 

• Video clip to be trimmed 

• Computer or mobile device with sufficient processing power and memory 

The assessment will involve the following tasks: 

1. Import the video clip into the video editing software 

2. Use the appropriate tool to trim the video clip by removing unwanted sections from 

the beginning, middle, or end of the clip 

3. Ensure that the trimmed section is seamless by using the ripple edit tool or by 

adding a cross dissolve transition 

4. Preview the trimmed video clip to ensure that it meets the desired length and 

quality 

5. Export the trimmed video clip as a separate file 

 

Task to be performed:  

The candidate will be asked to trim a provided video clip using a video editing software of 

their choice. The video clip will have specific sections that need to be removed, and the 

candidate will be required to ensure that the trimmed section is seamless and that the final 

output is of high quality. 

Observation checklist: 

1. Did the candidate use the appropriate tool to trim the video clip? 

2. Was the trimmed section seamless? 

3. Did the candidate preview the trimmed video clip to ensure that it met the desired 

length and quality? 

4. Did the candidate export the trimmed video clip as a separate file? 

5. Did the candidate demonstrate proficiency in using the selected video editing 

software? 
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Learning Unit 3: WORK WITH AUDIO 

 

 

STRUCTURE OF LEARNING UNIT  

Learning outcomes: 

1.1 Adjust audio 
1.2  Remove unwanted sound 
1.3 Mix music and sound track 
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Learning outcome 3.1 Adjust audio 

 

Duration: 1 hrs 

Learning outcome 1 objectives:  

By the end of the learning outcome, the trainees will be able to: 

1. Adjustment of amplitude 

2. Adjustment of audio effects and transitions  

3. Mix music and soundtrack 

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers,  Cables and Sound 
recorders 

Audio editing software: 
Adobe audition CC, 
Cubase, FL studio. 

 

Books ,Internet  ,Handout 
notes ,Drives ,Audio tutorials  
Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD Card 

Advance preparation: 

✓ Select the appropriate microphone: Choose the microphone that best suits the 
purpose of the recording.  

✓ Test equipment: Before recording or editing, test the recording equipment and 
software to ensure that they are working correctly. 

✓ Set levels: Use a sound level meter or software to set the recording levels 
appropriately to avoid distortion or noise. 

✓ Choose a quiet recording location: Choose a quiet location to record, away from 
any background noise or interruptions. 
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Indicative content 3.1.1:  Adjustment of amplitude  

 

✓ Adjusting volume in the effect control panel  
✓ Adjusting the volume using the timeline  
✓ Adjusting volume using key frames  
✓ Adjusting audio gain  

 

 

To adjust audio in Adobe Premiere Pro, follow these steps: 

1. Open your Premiere Pro project and locate the audio clip that you want to adjust. 

2. Click on the audio clip to select it, and then navigate to the Effects Control panel. 

3. In the Effects Control panel, you will see a variety of audio effects that you can apply 

to your clip. To adjust the volume of the audio clip, locate the "Volume" effect and 

drag the slider to increase or decrease the volume. 

4. To add an EQ effect, click on the "EQ" effect and adjust the frequency bands to boost 

or cut specific frequencies. 

5. To add a compression effect, click on the "Compressor" effect and adjust the 

threshold and ratio settings to even out the volume of the audio clip. 

6. To remove unwanted background noise, click on the "Noise Reduction" effect and 

adjust the settings to reduce the noise. 

7. To adjust the stereo balance of the audio clip, click on the "Stereo Balance" effect 

and adjust the pan position to adjust the placement of the audio in the stereo field. 

8. Once you have made your adjustments, preview the clip to ensure that the audio 

sounds the way you want it to. 

Adjusting amplitude in Adobe Premiere Pro refers to changing the volume of an audio clip. 

Here are the steps to adjust amplitude in Adobe Premiere Pro: 

1. Open your Premiere Pro project and locate the audio clip that you want to adjust. 

2. Click on the audio clip to select it, and then navigate to the Essential Sound panel. 

3. In the Essential Sound panel, you will see several options for adjusting your audio. To 

adjust amplitude, click on the "Volume" option. 

4. In the Volume settings, you can adjust the volume of the clip by dragging the slider 

up or down. You can also add keyframes to adjust the volume over time. 

5. If you want to adjust the volume of a specific section of the clip, you can use the pen 

tool to create keyframes and then adjust the volume between the keyframes. 
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6. Once you have made your adjustments, preview the clip to ensure that the audio 

sounds the way you want it to. 

By adjusting the amplitude of your audio clips in Adobe Premiere Pro, you can ensure that 

the audio levels are consistent and that the audio is at the appropriate volume for your 

video project. 

 

Indicative content 3.1.2:  Adjustment of audio effects and transitions  

 

 

 

 

 

To adjust audio effects and transitions in Adobe Premiere Pro, follow these steps: 

1. Open your Premiere Pro project and locate the audio clip that you want to apply 

effects and transitions to. 

2. Click on the audio clip to select it, and then navigate to the Effects Control panel. 

3. In the Effects Control panel, you will see a variety of audio effects that you can apply 

to your clip. To apply an effect, simply drag it onto the audio clip. 

4. To adjust an effect, click on the effect in the Effects Control panel and adjust the 

settings to your liking. For example, you can adjust the EQ settings, apply a reverb 

effect, or add compression to the audio clip. 

5. To apply a transition to the audio clip, click on the "Audio Transitions" tab in the 

Effects panel and drag the transition onto the clip. You can choose from a variety of 

transition options, including crossfades, dissolves, and wipes. 

6. To adjust the duration of a transition, click on the transition in the timeline and drag 

the edge of the transition to the desired length. 

7. Once you have applied your effects and transitions, preview the clip to ensure that 

the audio sounds the way you want it to. 

By adjusting audio effects and transitions in Adobe Premiere Pro, you can add depth and 

interest to your audio clips and create a more polished final product. 

 

 

✓ Application and adjustment of audio effects 

 Activation of audio effects panel 

 Choice of the right effect  

 Application of the effect  

✓ Application and adjustment of audio transitions 

 Activation of audio transitions panel 

 Choice of the right transition  

 Application of the transition 
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Theoretical learning Activity  

To assess students' understanding of audio amplitude, you could ask them to complete a 

short quiz or exam that covers the following topics: 

• Definition of audio amplitude 

• How to measure amplitude using decibels (dB) 

• Difference between peak amplitude and average amplitude 

• Factors that affect amplitude 

• How to manipulate amplitude using audio editing software 

Practical learning Activity  

For this assessment, you will be provided with a video clip and asked to adjust the audio 

in Adobe Premiere Pro. Follow these steps: 

1. Import the video clip into Adobe Premiere Pro. 

2. Identify any issues with the audio and determine how you can adjust it. 

3. Use the "Amplitude and Compression" effect to adjust the volume levels of the 

audio. 

4. Apply any additional effects or adjustments to the audio as necessary. 

5. Preview the adjusted audio to ensure that it sounds as desired. 

6. Export the final video with the adjusted audio. 

Observation Checklist: 

Did the student: 

• Identify any issues with the audio? 

• Use the "Amplitude and Compression" effect to adjust the volume levels of the 

audio? 

• Apply any additional effects or adjustments to the audio as necessary? 

• Preview the adjusted audio to ensure that it sounds as desired? 

• Export the final video with the adjusted audio? 

• Use appropriate terminology related to audio adjustment in Adobe Premiere Pro? 

Points to Remember (Take home message) 

1. Always use headphones 
2. Use the Audio track mixer 
3. Normalize audio levels 
4. Use key frames 
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5. Apply audio effects 
 

 
 
 
 
 
 

Learning outcome 3.2: Remove unwanted sound 

 

Duration: 1 hrs 

Learning outcome 2 objectives:  

By the end of the learning outcome, the trainees will be able to: 

1.  Edit Audio tracks   

2.  Clean audio  

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers,  Cables and Sound 
recorders 

Audio editing software: 
Adobe audition CC, 
Cubase, FL studio. 

 

Books ,Internet  ,Handout 

notes ,Drives ,Audio tutorials  

Paper, Pen, Internet, 

Batteries, CDs, DVDs, SD Card 

Advance preparation: 

✓ Select the appropriate microphone: Choose the microphone that best suits the 

purpose of the recording.  

✓ Test equipment: Before recording or editing, test the recording equipment and 

software to ensure that they are working correctly. 

✓ Set levels: Use a sound level meter or software to set the recording levels 

appropriately to avoid distortion or noise. 

✓ Choose a quiet recording location: Choose a quiet location to record, away from 

any background noise or interruptions. 
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Indicative content3.2.1: Audio tracks editing  

 

✓ Addition /Removal of audio tracks 
✓ Use of editing tools  

 

 

Remove unwanted sound in adobe premiere pro 

To remove unwanted sound in Adobe Premiere Pro, you can use the "Audio Clip Mixer" or 

"Audio Track Mixer" panel to adjust the levels of individual audio clips or tracks. Here are 

the steps: 

1. Open the "Audio Clip Mixer" or "Audio Track Mixer" panel by clicking on the 

appropriate tab in the workspace. 

2. Locate the audio clip or track that you want to adjust and click on the arrow next to 

its name to expand the controls. 

3. Use the volume slider to adjust the level of the clip or track. You can also use the 

mute button to turn off the sound completely. 

4. To remove unwanted background noise or hum, use the "Effects" panel to add the 

"Noise Reduction" effect to the clip or track. Adjust the settings until the unwanted 

noise is reduced or eliminated. 

5. You can also use the "Equalizer" effect to adjust the frequencies of the sound, which 

can help to remove unwanted sounds or enhance specific elements of the audio. 

6. Once you have made your adjustments, play the clip or sequence to check the 

results. Make any further adjustments as necessary. 

7. When you are satisfied with the changes, save your project and export your final 

video with the adjusted audio. 

Audio tracks editing  

Audio track editing in Adobe Premiere Pro is a straightforward process. Here are the basic 

steps: 

1. Open your project in Adobe Premiere Pro and navigate to the audio track you want to edit. 
2. To adjust the volume of the audio track, select the audio clip and go to the "Effect Controls" 

panel. Under "Audio," you will see a slider labeled "Volume." Adjust this slider to increase or 
decrease the volume of the audio track. 

3. To fade in or fade out the audio track, you can use the "Opacity" option in the "Effect 
Controls" panel. This option is located under "Audio Transitions." Click on the dropdown 
arrow next to "Audio Transitions" to reveal the options, then select "Constant Gain." Drag 
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this effect onto the beginning or end of the audio clip, and adjust the length of the transition 
as desired. 

4. If you need to trim or cut the audio track, use the razor tool to split the clip at the desired 
point. Then, delete the unwanted section of the clip by selecting it and pressing the delete 
key on your keyboard. 

5. You can also add effects to the audio track to enhance the sound quality. To do this, go to 
the "Effects" panel and browse for the effect you want to add. Drag the effect onto the 
audio clip, and adjust the settings as needed in the "Effect Controls" panel. 

6. Once you have finished editing the audio track, preview the clip to make sure the changes 
are satisfactory. If you need to make further adjustments, repeat the steps above until you 
are satisfied with the result. 

7. Finally, export your video with the edited audio track by selecting "File" > "Export" and 
choosing your desired output format. 

 

Indicative content 3.2.2:  Audio Cleaning  

 

 

 

 

 

Audio Cleaning  
 
Audio cleaning is the process of removing unwanted noise or improving the overall quality 

of audio recordings. Adobe Audition is a popular audio editing software that offers various 

tools to clean up audio. 

Here are some steps to clean audio in Adobe Audition: 

1. Open the audio file in Adobe Audition. 

2. Use the selection tool to select the section of audio you want to clean. 

3. Go to the "Effects" tab and select "Noise Reduction/Restoration" > "Noise Reduction 

(process)". 

4. In the "Noise Reduction (process)" dialog box, click the "Capture Noise Print" button 

to analyze the selected section of audio and capture the noise profile. 

5. Once the noise profile is captured, select the entire audio file by pressing "Ctrl+A" 

(Windows) or "Command+A" (Mac). 

6. Go back to the "Noise Reduction (process)" dialog box and adjust the "Reduction" 

slider to reduce the noise in the audio. 

✓ Noise and echoes Removal  

 Audio channels management  

 Use of effects 
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7. Preview the audio to check if the noise reduction is satisfactory. If needed, adjust the 

"Reduction" slider further until the audio sounds clear. 

8. Once you are satisfied with the result, click "OK" to apply the noise reduction. 

 

Theoretical learning Activity  

✓ Discuss with the respective groups how unwanted sound can be removed or 

reduced using audio editing software. 

✓ Ask trainees to demonstrate how to import the video clip into an audio 

editing software, such as Audacity, and use features like noise reduction, 

equalization, and compression to remove or reduce unwanted sound. 

  

Practical learning Activity  

Here's a practical assessment checklist for removing unwanted sound in Adobe Premiere 
Pro: 

1. Import the video file into Adobe Premiere Pro. 
2. Identify the unwanted sound in the video. 
3. Select the audio clip that contains the unwanted sound. 
4. Open the Audio Effects panel by selecting Window > Audio Effects from the main menu. 
5. Locate the Noise Reduction effect and drag it onto the audio clip. 
6. Adjust the settings in the Effect Controls panel, including Noise Reduction, Reduce By, and 

Sensitivity. 
7. Preview the edited audio clip to see if the unwanted sound has been removed. 
8. If necessary, adjust the settings and preview again until you are satisfied with the result. 
9. Export the video file using the desired format and settings. 

Checklist: 

• Did you import the video file into Adobe Premiere Pro? 
• Did you identify the unwanted sound in the video? 
• Did you select the audio clip that contains the unwanted sound? 
• Did you open the Audio Effects panel? 
• Did you locate the Noise Reduction effect and drag it onto the audio clip? 
• Did you adjust the settings in the Effect Controls panel, including Noise Reduction, Reduce 

By, and Sensitivity? 
• Did you preview the edited audio clip to see if the unwanted sound has been removed? 
• Did you adjust the settings and preview again if necessary until you were satisfied with the 

result? 
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• Did you export the video file using the desired format and settings? 

 

Points to Remember (Take home message) 

 

Here are some important points to remember about removing unwanted sound in 
Adobe Premiere Pro: 

1. Always work with a copy of your original video file to avoid losing any 
important data or changes made during the editing process. 

2. Before removing any unwanted sound, it's important to identify the specific 
sound you want to remove and its location within the video clip. 

3. The Noise Reduction effect is the most commonly used tool for removing 
unwanted sound in Adobe Premiere Pro. 

4. It's important to adjust the settings of the Noise Reduction effect carefully 
to avoid removing any desired sounds or causing distortion. 

5. Always preview the edited audio clip to ensure that the unwanted sound 
has been removed without affecting the overall quality of the audio. 

 

 

Learning outcome3.3: Mix music and soundtracks 

Duration: 1 hrs 

Learning outcome 1 objectives:  

By the end of the learning outcome, the trainees will be able to: 

1. Mix soundtracks 

2. Add music to the timeline 

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers,  Cables and Sound 
recorders 

Audio editing software: 
Adobe audition CC, 
Cubase, FL studio. 

 

Books ,Internet  ,Handout 

notes ,Drives ,Audio tutorials  

Paper, Pen, Internet, 

Batteries, CDs, DVDs, SD Card 

Advance preparation: 

✓ Select the appropriate microphone: Choose the microphone that best suits the 
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purpose of the recording.  

✓ Test equipment: Before recording or editing, test the recording equipment and 

software to ensure that they are working correctly. 

✓ Set levels: Use a sound level meter or software to set the recording levels 

appropriately to avoid distortion or noise. 

✓ Choose a quiet recording location: Choose a quiet location to record, away from 

any background noise or interruptions. 

 

 

Indicative content3.3.1:  Addition of music to the timeline and Mixing soundtracks 

 

 

• Addition of music to the timeline 
✓ Use of editing tools  
✓ Synchronization of music with action 

• Mixing soundtracks 
 
 

 

Mix music and soundtracks in adobe premiere pro 

To mix music and soundtracks in Adobe Premiere Pro, you can follow these steps: 

1. Import the music and soundtracks: In the project panel, import the music and 

soundtracks that you want to use in your video. To import files, click on "File" in the 

menu bar and select "Import." 

2. Create a new sequence: Click on "File" in the menu bar and select "New Sequence." 

Choose the appropriate settings for your project. 

3. Add the music and soundtracks to the timeline: Drag the music and soundtracks 

from the project panel to the timeline in the order that you want them to appear. 

4. Adjust the volume: To adjust the volume of the music or soundtracks, click on the 

audio clip in the timeline and then use the "Audio Clip Mixer" panel to adjust the 

volume level. 

5. Add transitions: To create smooth transitions between different music tracks or 

soundtracks, add audio transitions. To do this, click on the audio clip in the timeline 

and then select "Effect Controls." From here, you can choose the type of transition 

you want to use, such as a crossfade. 

6. Adjust the overall audio levels: Once you have all of the music and soundtracks in 

place, adjust the overall audio levels for your video. You can do this by selecting the 
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entire sequence in the timeline and then using the "Audio Track Mixer" panel to 

adjust the volume level. 

7. Preview and export: Preview your video to make sure that the audio levels are 

balanced and everything sounds good. When you are ready to export, click on "File" 

in the menu bar and select "Export" to save your video. 

Theoretical learning Activity  

Ask trainees to discuss the process of mixing music and soundtracks in Adobe Premiere Pro.  

 

Practical learning Activity  

Instructions: 

1. Provide students with a sample video clip with no audio track and an audio file of a 

music track. 

2. Instruct students to add the music track to the video timeline and adjust the volume 

level to complement the visuals in the video. 

3. Next, provide students with an additional audio file of a sound effect or voice-over 

that needs to be mixed with the music track. 

4. Instruct students to use audio editing software to mix the music track and the 

additional audio file together, ensuring that the volume levels are balanced and the 

sound is clear and high-quality. 

5. Finally, ask students to export the final video with the mixed audio track. 

Checklist: 

Use the following checklist to evaluate students' work: 

Adding Music to the Timeline 

• Music track has been added to the video timeline 

• Volume level of the music track complements the visuals in the video 

• Music track has been trimmed or edited to fit the length of the video clip 

Mixing Soundtracks 

• Additional audio file has been imported into audio editing software 

• Music track and additional audio file have been mixed together 

• Volume levels of the music track and additional audio file are balanced 

• Sound is clear and high-quality 

• Music and additional audio file have been synchronized with the video clip 



84 
 

Final Product 

• Exported video includes mixed audio track 

• Sound quality is consistent throughout the video 

• Audio levels are appropriate for the type of video (e.g. voice-over is clear and prominent 

in a tutorial video) 

Assessment Grading: 

Use the following grading scale to assess students' work: 

• 90-100%: Excellent work, all checklist items have been completed to a high standard. 

• 80-89%: Good work, most checklist items have been completed to a high standard. 

• 70-79%: Satisfactory work, some checklist items have been completed to a high 

standard. 

• Below 70%: Needs improvement, several checklist items have not been completed to 

a high standard. 

 

Points to Remember (Take home message) 

 

✓ Use of editing tools  

✓ Synchronization of music with action 

Learning unit 3 formative assessment 

Written assessment 

1. To adjust the volume levels of an audio clip in Adobe Premiere Pro, you can drag the 

volume slider up or down in the audio track mixer panel. True 

2. Audio effects can be added to audio clips in Adobe Premiere Pro to enhance the sound 

quality. True 

3. It is not possible to adjust the volume levels of multiple audio tracks at once in Adobe 

Premiere Pro. False 

4. The master audio track in the audio track mixer panel is used to adjust the overall sound 

levels of the project in Adobe Premiere Pro. True 

5. EQ (equalization), reverb, compression, and noise reduction are examples of audio 

effects that can be used in Adobe Premiere Pro. True 
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6. What are some common challenges you have faced when adjusting audio in Adobe 

Premiere Pro? How have you overcome these challenges? 

Answer: One common challenge when adjusting audio in Adobe Premiere Pro is getting the 

right balance between different audio tracks. This can be especially tricky when working 

with a lot of different sounds or when there is dialogue that needs to be heard clearly over 

music or sound effects. To overcome this challenge, it can be helpful to create separate 

audio tracks for dialogue, sound effects, and music, and then adjust the volume levels for 

each track individually. Another challenge can be removing unwanted background noise 

from audio recordings. Adobe Premiere Pro has a built-in noise reduction tool that can be 

helpful in these situations. 

7. How do you determine the appropriate volume levels for your audio tracks in Adobe 

Premiere Pro? What factors do you consider? 

Answer: The appropriate volume levels for audio tracks in Adobe Premiere Pro depend on 

several factors, such as the type of content, the desired mood or atmosphere, and the 

overall sound design of the project. Generally, dialogue should be loud enough to be heard 

clearly, but not so loud that it overpowers other sounds in the mix. Music and sound effects 

should be balanced so that they enhance the emotional impact of the visuals without 

overwhelming the audience. When determining appropriate volume levels, it can be helpful 

to listen to the audio in different environments (such as with headphones or on different 

speakers) to ensure that it sounds good across a variety of playback systems. 

8. In what situations do you typically use EQ (equalization) or other audio effects in Adobe 

Premiere Pro? Can you give an example of a project where you used these effects and 

why? 

Answer: EQ (equalization) and other audio effects can be used in a variety of situations in 

Adobe Premiere Pro. For example, EQ can be used to boost or cut certain frequency ranges 

to make dialogue or music sound clearer or more dynamic. Reverb can be used to add depth 

or space to audio recordings. Compression can be used to even out the dynamic range of a 

recording and make it sound more consistent. Noise reduction can be used to remove 

unwanted background noise from audio recordings. In a recent project, I used EQ to boost 

the low frequencies of a voiceover recording to make it sound warmer and more resonant. 

9. How do you ensure that the music you add to your video project in Adobe Premiere Pro 

blends well with the audio tracks? What techniques do you use to achieve this? 

Answer: To ensure that music blends well with audio tracks in Adobe Premiere Pro, it can be 

helpful to choose music that has a similar mood or tempo to the visuals. It's also important 

to adjust the volume levels so that the music doesn't overpower the dialogue or other 

sounds in the mix. Using audio effects like EQ or reverb can also help create a more cohesive 

sound design. One technique I often use is to adjust the volume levels of the music track so 

that it dips down slightly during dialogue, then rises back up when the dialogue is finished. 

This can help ensure that the dialogue is always clear and easy to understand. 
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10. How do you approach adjusting the overall sound levels of your project in Adobe 

Premiere Pro? What methods have you found to be effective in achieving a well-

balanced mix? 

Answer: When adjusting the overall sound levels of a project in Adobe Premiere Pro, I 

typically start by adjusting the volume levels of each individual track so that they sound 

good on their own. I then adjust the levels of each track relative to one another to achieve a 

balanced mix. The master audio track in the audio track mixer panel can be used to adjust 

the overall sound levels of the project. I often use headphones or reference monitors to 

ensure that the sound levels are consistent across 

11. How do you adjust the volume levels of individual audio tracks in Adobe Premiere Pro? 
Answer: To adjust the volume levels of individual audio tracks in Adobe Premiere Pro, you 

can use the Audio Track Mixer panel. First, ensure that the panel is visible by selecting 

Window > Audio Track Mixer from the main menu. Then, select the track you want to adjust 

and use the fader to adjust its volume level. You can also adjust the panning and mute/solo 

settings for each track in this panel. 

12. What are some common audio effects that you can use to enhance the sound of your 

project in Adobe Premiere Pro? 

Answer: Some common audio effects in Adobe Premiere Pro include EQ (equalization), 

compression, reverb, and noise reduction. EQ can be used to adjust the frequency balance 

of an audio recording, while compression can be used to even out the dynamic range of a 

recording. Reverb can be used to add depth or space to an audio recording, and noise 

reduction can be used to remove unwanted background noise. 

13. How do you remove unwanted background noise from an audio recording in Adobe 

Premiere Pro? 

Answer: To remove unwanted background noise from an audio recording in Adobe Premiere 

Pro, you can use the Noise Reduction effect. First, select the clip with the unwanted noise in 

the timeline. Then, go to the Effects panel and search for "Noise Reduction." Drag and drop 

the effect onto the clip and adjust the settings to reduce the noise. You can preview the 

effect by playing back the clip with the effect applied. 

14. What is the audio track mixer panel in Adobe Premiere Pro, and how can it be used to 

adjust the sound levels of your project? 

Answer: The Audio Track Mixer panel in Adobe Premiere Pro is used to adjust the sound 

levels of your project. It allows you to adjust the volume, panning, and mute/solo settings 

for each audio track individually. To access the panel, select Window > Audio Track Mixer 

from the main menu. You can then adjust the levels of each track using the fader, and use 

the pan knob to adjust the stereo position of each track. 
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Practical assessment 

Here's a practical assessment for adjusting audio in Adobe Premiere Pro: 

Task: Edit a 2-minute video with background music and voiceover. Adjust the audio levels 

and apply effects to achieve a balanced and professional sound. 

Requirements: 

• Adobe Premiere Pro software 

• Video footage with voiceover 

• Background music 

• Headphones or speakers for monitoring audio 

• Computer with sufficient processing power and storage space 

Steps: 

1. Import the video footage and background music into Adobe Premiere Pro. 

2. Drag the video footage to the timeline and add the background music to a separate 

audio track. 

3. Listen to the voiceover and background music to identify any issues with the audio 

levels. 

4. Use the Gain effect to adjust the overall volume of the voiceover and background 

music. 

5. Use the EQ effect to adjust the frequency balance of the voiceover and background 

music as needed. 

6. Use the Compression effect to even out the dynamic range of the voiceover and 

background music. 

7. Use the Noise Reduction effect to remove any unwanted background noise from the 

voiceover. 

8. Use the Reverb effect to add depth or space to the voiceover as needed. 

9. Use keyframes to adjust the volume levels of specific parts of the audio clip, such as 

when the music needs to be lowered to allow the voiceover to be heard clearly. 

10. Preview the edited audio and adjust as needed to achieve the desired effect. 

11. Export the video with the adjusted audio and save the project file. 

Assessment Criteria: 

• Audio levels are balanced and appropriate for the content. 

• Audio effects are applied effectively to achieve a professional sound. 

• Keyframes are used to adjust the volume levels of specific parts of the audio clip. 

• The edited audio is smooth and natural-sounding. 

• The video is exported with the adjusted audio and saved as a project file. 
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Learning Unit 4: Export project 

 

 

 

STRUCTURE OF LEARNING UNIT  

Learning outcomes: 

1.1 Name files and choose file location 
1.2 Choose the formats and codec settings 
1.3 Save and share the project 
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Learning outcome 4.1 Name files and choose file location 

 

Duration: 3hrs 

Learning outcome 1 objectives:  

By the end of the learning outcome, the trainees will be able to: 

1 Give File name  

2 Specify File location 

3 Respect File naming convention 

 

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software and 
exporting software: Adobe 
Premiere Pro CC,Adobe 
Media Encoder Pro CC Final 
Cut Pro, Adobe Premiere 
Clips, Sony Vegas Pro, Adobe 
After Effects, DaVinci 
Resolve, Red Giant, Video 
Copilot 

 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD 
Card 

Advance preparation : 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 

. RAW footages 
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Indicative content4.1.1:  File structure  

 
1. File name  
2. File location 
3. File naming convention 

 

 

To name files and choose a file location in Premiere Pro exporting, follow these steps: 

1. Click on "File" in the menu bar and select "Export" > "Media". Alternatively, you can 

use the shortcut key "Ctrl+M" (Windows) or "Command+M" (Mac). 

2. In the Export Settings panel, specify the format and presets for the exported file. 

3. In the "Export Settings" section, you can choose the file format, preset, and output 

name. Click on the "Output Name" field to enter the name of your file. 

4. Click on the "Browse" button next to the "Output Name" field to choose the file 

location where you want to save your exported file. 

5. Navigate to the folder where you want to save the file, and click on the "Save" 

button. 

6. Finally, click on the "Export" button to start exporting your project to the specified 

location with the given name. 

When naming files during export in Premiere Pro, it's best to follow a consistent and clear 

naming convention to avoid confusion and make it easy to identify your files. Here are some 

tips for naming files during export: 

1. Start with a descriptive name that identifies the project, scene or clip you are 

exporting. 

2. Use underscores (_) or hyphens (-) to separate words in the file name, rather than 

spaces or special characters. For example, "my_project_export" instead of "My 

Project Export!". 

3. Include the date of export in the file name if you are exporting multiple versions of 

the same project. For example, "my_project_export_20230418" to indicate that the 

file was exported on April 18, 2023. 

4. If you are exporting different formats or resolutions, include that information in the 

file name. For example, "my_project_export_1080p" or "my_project_export_web". 

5. Be consistent with your naming convention across all files to make it easy to organize 

and locate them. 
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Remember that a clear and descriptive file name can save you time and frustration later on 

when trying to find the right file. 

Theoretical learning Activity  

Naming files and choosing the file location during export is an essential part of the post-

production process in Premiere Pro. Proper naming conventions and organization can make 

it easier to locate and work with files later on. In this theoretical activity, ask trainees to 

brainstorm  the importance of naming files and choosing the file location during export and 

discuss some best practices. 

 

Practical learning Activity  

Practical Assessment Activity: 

Assume you have just finished editing a video project in Premiere Pro, and you need to 

export the project for final delivery. Your task is to name the file appropriately and choose 

the correct file location during export. 

Instructions: 

1. Open your Premiere Pro project and navigate to the export settings. 

2. Choose the appropriate format and preset for your project. 

3. Name your file with a clear and descriptive title that accurately reflects the project. 

4. Choose the correct file location where you want to save the exported file. 

5. Ensure that the file name and location are consistent with your file naming 

convention and file organization structure. 

Checklist: 

Before exporting your Premiere Pro project, use this checklist to ensure that they have 

named their files appropriately and chosen the correct file location: 

• Have you chosen the appropriate file format and preset for your project? 

• Have you given the file a clear and descriptive name that accurately reflects the 

project? 

• Does the file name include any additional information such as date or version 

number if necessary? 

• Have you used underscores (_) or hyphens (-) to separate words in the file name? 

• Have you chosen a location to save the file that is easily accessible and has enough 

storage space? 

• Does the file location fit with your file organization structure? 
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• Have you double-checked the file name and location to ensure that they are 

consistent with your naming convention and file structure? 

By following this checklist, you can ensure that you have named your files appropriately and 

chosen the correct file location during export in Premiere Pro, making it easier to manage 

and locate your files later on. 

 

Points to Remember (Take home message) 

Here are some important points to remember about naming files and choosing file 
locations during export in Premiere Pro: 

1. Naming files during export is important for identifying the content, 
distinguishing it from other files, and making it easier to locate and organize 
files later on. 

2. Use a descriptive name that accurately reflects the project or clip you are 
exporting, and use underscores (_) or hyphens (-) to separate words in the file 
name. 

3. Include additional information in the file name, such as date or version 
number, if necessary. 

4. Choose a file location that is easily accessible, has enough storage space, and 
fits with your file organization structure. 

5. Consider using a consistent file structure for your projects and saving all 
exported files in a dedicated folder for the project. 

6. Use external hard drives or cloud storage for backup and easy sharing. 
7. Poor naming conventions and file location choices can lead to difficulty 

locating files, confusion when working with multiple versions of the same 
project, loss of files, and inconsistency across projects. 

 

 

Learning outcome4.2: choose the video formats and codecs 

Duration: 7hrs 

Learning outcome 1 objectives:  

By the end of the learning outcome, the trainees will be able to: 

1. Specify video formats  

2. Specify video Codecs  

Resources 
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Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software and 
exporting software: Adobe 
Premiere Pro CC,Adobe 
Media Encoder Pro CC Final 
Cut Pro, Adobe Premiere 
Clips, Sony Vegas Pro, Adobe 
After Effects, DaVinci 
Resolve, Red Giant, Video 
Copilot 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD 
Card 

Advance preparation : 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 

. RAW footages 

 

 

 

 
 

 

Indicative content4.2.2: Video formats  

✓ MOV  
✓ AVI 
✓ MP4  
✓ FLV  
✓ WMV 
✓ MKV  

 

 

 
MOV export video format 

MOV (QuickTime Movie) is a video file format developed by Apple Inc. It is a multimedia 
container format that can store multiple types of media, including video, audio, and text. 
MOV is a popular video format used for video editing, broadcasting, and playback on Apple 
devices and applications such as QuickTime and iTunes. 
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MOV supports a range of video codecs, including H.264, MPEG-4, and Apple ProRes, which 
are widely used in professional video production. The format also supports high-quality 
audio and can include captions and other metadata. 

When exporting videos from Premiere Pro, MOV is a commonly used format due to its 
versatility, high quality, and compatibility with Apple devices and applications. However, it is 
important to note that the MOV format can result in large file sizes, which can be an issue 
when sharing or storing the files. In such cases, it may be necessary to compress or 
transcode the video to reduce the file size while maintaining the desired quality. 

 
Avi export video format 

AVI (Audio Video Interleave) is a video file format that was developed by Microsoft in the 
early 1990s. It is a multimedia container format that can store both audio and video data. 
AVI files use various codecs, which are used to compress the video and audio data. 

AVI was one of the most popular video formats in the early days of digital video, but its use 
has decreased in recent years due to the emergence of more modern and efficient formats 
such as MP4 and MOV. 

In Premiere Pro, AVI is still a supported format for export, but it may not be the best choice 
in all cases. AVI files can be large in size and may not be compatible with all devices and 
applications. Additionally, the quality of the video can be affected by the codec used for 
compression. 

If you choose to export your video in AVI format, it is important to select the appropriate 
codec that will maintain the desired quality while keeping the file size manageable. It is also 
recommended to test the exported file on various devices and applications to ensure 
compatibility. 

Overall, while AVI is still a viable option for video export in Premiere Pro, it is recommended 
to consider more modern and efficient formats, such as MP4 or MOV, depending on your 
specific needs and requirements. 

 
MP4 export video format 

MP4 (MPEG-4 Part 14) is a popular video file format that was developed by the Moving 
Picture Experts Group (MPEG). It is a multimedia container format that can store video, 
audio, and subtitles in a single file. 

MP4 is a highly versatile and widely used video format that is supported by a wide range of 
devices and applications, including mobile phones, tablets, computers, and web browsers. It 
is also compatible with a variety of codecs, which are used to compress the video and audio 
data. 
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When exporting videos from Premiere Pro, MP4 is a commonly used format due to its 
versatility, high quality, and compatibility with a wide range of devices and applications. It is 
also known for its relatively small file size, which makes it ideal for sharing and uploading 
videos online. 

However, it is important to select the appropriate codec and settings when exporting videos 
in MP4 format to ensure the desired quality and compatibility. The H.264 codec is a popular 
choice for MP4 export as it provides a good balance between file size and quality. 

Overall, MP4 is a highly recommended format for video export in Premiere Pro due to its 
versatility, compatibility, and small file size. 

 
 
 
 
 
FLV export video format 

FLV (Flash Video) is a video file format that was developed by Adobe Systems for use with 
the Adobe Flash Player. It is a container format that can store video, audio, and other data, 
and it is commonly used for streaming video content over the internet. 

FLV is typically used for web-based video content, such as online video players and video 
sharing sites. It is known for its relatively small file size and its ability to support interactivity 
and streaming. 

While FLV is still a supported format for export in Premiere Pro, its use has declined in 
recent years due to the emergence of more modern and efficient formats, such as MP4 and 
MOV. Additionally, FLV may not be compatible with all devices and applications, which can 
limit its usefulness. 

If you choose to export your video in FLV format, it is important to select the appropriate 
codec and settings to ensure the desired quality and compatibility. The H.264 codec is 
commonly used for FLV export as it provides a good balance between file size and quality. 

Overall, while FLV can still be a viable option for web-based video content, it is 
recommended to consider more modern and efficient formats, such as MP4 or MOV, 
depending on your specific needs and requirements. 

 
WMV export video format 

WMV (Windows Media Video) is a video file format developed by Microsoft that is 
commonly used for streaming video over the internet and for playback on Windows-based 
devices and applications. 
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WMV files use various codecs to compress the video and audio data, which can result in 
smaller file sizes than some other formats. However, the quality of the video can be affected 
by the codec used for compression, and WMV may not be as widely supported as some 
other formats. 

While WMV is still a supported format for export in Premiere Pro, its use has declined in 
recent years due to the emergence of more modern and efficient formats, such as MP4 and 
MOV. Additionally, WMV may not be compatible with all devices and applications, which 
can limit its usefulness. 

If you choose to export your video in WMV format, it is important to select the appropriate 
codec and settings to ensure the desired quality and compatibility. The Windows Media 
Video 9 codec is commonly used for WMV export as it provides a good balance between file 
size and quality. 

Overall, while WMV can still be a viable option for Windows-based video content, it is 
recommended to consider more modern and efficient formats, such as MP4 or MOV, 
depending on your specific needs and requirements. 

 
MKV export video format 

MKV (Matroska Video) is a video file format that is designed to be an open and flexible 
alternative to other container formats, such as MP4 and AVI. It can store video, audio, 
subtitles, and other data in a single file. 

MKV is known for its flexibility and support for a wide range of codecs, which can result in 
high-quality video with relatively small file sizes. Additionally, it supports advanced features 
such as chapter markers, multiple audio and subtitle tracks, and menu navigation. 

While MKV is not as widely supported as some other formats, it is increasingly used for high-
quality video content, such as Blu-ray rips and high-resolution video files. Some media 
players and streaming devices also support MKV playback. 

If you choose to export your video in MKV format, it is important to select the appropriate 
codec and settings to ensure the desired quality and compatibility. The H.264 codec is 
commonly used for MKV export as it provides a good balance between file size and quality. 

Overall, MKV can be a good option for high-quality video content, especially if you need 
advanced features such as multiple audio and subtitle tracks or menu navigation. However, 
it may not be as widely supported as some other formats, so it is important to consider your 
specific needs and requirements when selecting a video export format. 
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Indicative Content 4.2.2. Video Codecs DivX  

DivX is a video codec that was developed by DivX Inc. It is based on the MPEG-4 Part 2 video 
compression standard and is designed to provide high-quality video with relatively small file 
sizes. DivX is known for its ability to compress video files to a fraction of their original size 
while maintaining high quality. 

DivX is widely used for video playback on a variety of devices, including DVD players, gaming 
consoles, and streaming devices. It is also commonly used for online video distribution and 
sharing. 

One of the key features of DivX is its support for advanced features such as multiple audio 
tracks, subtitles, and chapter markers, which make it a popular choice for movie and TV 
show downloads. 

Overall, DivX is a popular video codec that is known for its high quality and small file sizes. It 
is widely supported by a variety of devices and applications, making it a versatile choice for 
video compression and distribution. 

 
Video Codecs XviD  

XviD is a video codec that is based on the MPEG-4 Part 2 video compression standard, 
similar to DivX. It was developed as an open-source alternative to DivX and is designed to 
provide high-quality video with relatively small file sizes. 

XviD is known for its ability to compress video files to a fraction of their original size while 
maintaining high quality. It is widely used for video playback on a variety of devices, 
including DVD players, gaming consoles, and streaming devices. 

Like DivX, XviD supports advanced features such as multiple audio tracks, subtitles, and 
chapter markers. It is also commonly used for online video distribution and sharing. 

One of the key differences between XviD and DivX is that XviD is an open-source project, 
while DivX is a proprietary technology. This means that XviD is freely available for use and 
modification by anyone, while DivX is controlled by a single company. 

Overall, XviD is a popular video codec that is known for its high quality and small file sizes. It 
is widely supported by a variety of devices and applications, making it a versatile choice for 
video compression and distribution. 
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Video Codecs X264  

x264 is a free and open-source software library and application for encoding video streams 
into the H.264/MPEG-4 AVC format. It is widely used for high-quality video compression, 
particularly in applications such as Blu-ray disc authoring and online video streaming. 

x264 is known for its high compression efficiency, allowing for smaller file sizes without 
significant loss of quality. It also supports a wide range of advanced features, such as 
multiple reference frames, adaptive quantization, and rate control algorithms, which help to 
optimize the video compression process for different types of content. 

One of the key benefits of x264 is its versatility, with support for a wide range of video 
resolutions and frame rates. It is also compatible with a variety of devices and applications, 
making it a popular choice for video encoding in many different industries. 

Overall, x264 is a powerful and flexible video codec that is widely used for high-quality video 
compression. Its advanced features and efficient compression make it a popular choice for a 
variety of applications, from professional video production to online streaming and 
distribution. 

 
Video Codecs ProRes 4:4:4  

ProRes 4:4:4 is a video codec developed by Apple for high-quality video production. It is 
designed to provide lossless compression of high-resolution video, allowing for maximum 
image quality while minimizing storage requirements. 

ProRes 4:4:4 is part of the ProRes family of codecs, which includes a range of different 
compression levels and quality settings. It is intended for use in professional video 
production, where image quality is critical and file sizes can be very large. 

One of the key features of ProRes 4:4:4 is its support for 12-bit color depth, which provides 
a wide color gamut and greater color precision than other codecs. This makes it an ideal 
choice for high-end video production, such as feature films and television dramas. 

ProRes 4:4:4 also supports alpha channels, which allow for transparency and compositing 
effects to be applied to video footage. This is important for many types of video production, 
including visual effects and animation. 

Overall, ProRes 4:4:4 is a powerful and flexible video codec that is widely used in 
professional video production. Its lossless compression and high color precision make it an 
ideal choice for high-quality video projects where image quality is a top priority. 

 
Video Codecs ProRes 4:2:2  
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ProRes 4:2:2 is a video codec developed by Apple for high-quality video production. It is 
designed to provide high-quality compression of video footage while maintaining a 
reasonable file size. 

ProRes 4:2:2 is part of the ProRes family of codecs, which includes a range of different 
compression levels and quality settings. It is intended for use in professional video 
production, where image quality is critical and file sizes need to be manageable. 

One of the key features of ProRes 4:2:2 is its support for 10-bit color depth, which provides 
a wide color gamut and greater color precision than other codecs. This makes it an ideal 
choice for high-end video production, such as feature films and television dramas. 

ProRes 4:2:2 also supports alpha channels, which allow for transparency and compositing 
effects to be applied to video footage. This is important for many types of video production, 
including visual effects and animation. 

Overall, ProRes 4:2:2 is a powerful and flexible video codec that is widely used in 
professional video production. Its high-quality compression and support for 10-bit color 
depth make it an ideal choice for high-quality video projects where image quality is a top 
priority, while still keeping file sizes manageable. 

 

Theoretical learning Activity 

Ask students to brainstorm Theatrical activity about export video format and provide the 
answers 

Sure, here are some potential answers to the brainstorming prompts I provided earlier: 

✓ Ask the trainees to discuss the technical specifications of the devices that will be 

used to play the video? What video formats do they support? 

✓ Ask trainees to explore the features of different video formats, such as compression 

methods, audio and video codec’s, and container formats? 

Practical learning Activity  

Sure, here is a practical assessment activity and checklist for choosing an export video 

format: 

Activity: 

1. Choose a video project in Adobe Premiere Pro that you want to export. 
2. Determine the intended use of the video (e.g. online streaming, TV broadcast, etc.), the 

target audience (e.g. computer, mobile, TV), and the desired playback quality (e.g. high-
resolution, lower resolution). 
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3. Research different video formats and their technical specifications, including compression 
methods, audio and video codecs, and container formats. 

4. Choose a video format that meets the requirements of the intended use, target audience, 
and desired playback quality. 

5. Export the video in the chosen format and check the quality and compatibility with different 
devices. 
Checklist: 

• Determine the intended use of the video 
• Determine the target audience for the video 
• Determine the desired playback quality for the video 
• Research different video formats and their technical specifications 
• Choose a video format that meets the requirements of the intended use, target audience, 

and desired playback quality 
• Check the compatibility of the video format with different devices 
• Check the quality of the exported video in the chosen format 
• Consider the file size limitations and balance file size with video quality 
• Consider the distribution method of the video and choose a format that is compatible with 

the intended delivery method. 

 

Points to Remember (Take home message) 

Video formats and codecs are two important components that determine the 
quality and compatibility of digital video files. Here are some key points to 
remember about these topics: 
Video formats: A video format is a file type that determines how video data is 
stored and encoded. Examples of popular video formats include MP4, AVI, MOV, 
and WMV. 
Codecs: A codec (short for coder-decoder) is a program that encodes and decodes 
digital video data. Codecs are used to compress video data for storage and 
transmission, and to decompress it for playback. Some examples of popular video 
codecs include H.264, HEVC, and VP9. 
Compression: Compression is the process of reducing the size of a digital video file. 
Compression is necessary because video files can be very large and take up a lot of 
storage space. Codecs use different compression algorithms to reduce the size of 
video files while preserving video quality. 
Compatibility: Not all video formats and codecs are compatible with all devices and 
software. For example, some video formats may not play on certain media players 
or operating systems, and some codecs may not be supported by certain video 
editing software. 
Quality: The quality of a digital video file depends on several factors, including the 
resolution, bitrate, and codec used. Higher resolution and bitrate generally result in 
better quality video, but also larger file sizes. 
Choosing the right format and codec: When choosing a video format and codec, 
it's important to consider factors such as compatibility, quality, and file size. 
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Different formats and codecs may be more suitable for different purposes, such as 
streaming, editing, or archiving video files. 

 

 

Learning outcome 4. 3: Save and share the project 

Duration: 3hrs 

Learning outcome 3 objectives:  

By the end of the learning outcome, the trainees will be able to: 

✓ Save on the storage devices 

✓ Identify the  video playing devices 

✓ save online videos format 

Resources 

Equipment  Tools Materials  

Computer, Headphones, 
Speakers, Video Cables, 
Video Monitors Video Tapes, 
Flash, Memory Cards or 
DVD's, external hard disks, 
DVD player 

 

Video editing software and 
exporting software: Adobe 
Premiere Pro CC,Adobe 
Media Encoder Pro CC Final 
Cut Pro, Adobe Premiere 
Clips, Sony Vegas Pro, Adobe 
After Effects, DaVinci 
Resolve, Red Giant, Video 
Copilot 

 

Books  

Internet   

Handout notes  

Drives  

Video tutorials  

Paper, Pen, Internet, 
Batteries, CDs, DVDs, SD 
Card 

Advance preparation : 

. Use Pre-Prepared Illustrations 

. Downloaded editing tutorials. 

. RAW footages 
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Indicative content4.3.1: saving and sharing option 

 
✓ Saving on the storage devices 

 Optical Drive  
 External Hard Drive  
 Cloud Storage  

✓ Identification of video playing devices 
✓ Saving online video format 

 

 

To save and share a project in Adobe Premiere Pro, you can follow these steps: 

1. Save your project: Click on "File" in the top menu, then select "Save" or "Save As" if 

you want to create a new file. Choose a name and location for the project, then click 

"Save." 

2. Export your project: Click on "File" in the top menu, then select "Export" and "Media 

 Here are the steps to share a project in Adobe Premiere Pro: 

1. Open your project in Adobe Premiere Pro. 

2. Go to the "File" menu and select "Export" > "Media". 

3. In the Export Settings window, select the format and preset you want to use for your 

exported file. 

4. Choose the destination folder where you want to save your exported file. 

5. Click on the "Export" button to start the exporting process. 

Alternatively, if you want to share your project with another editor or collaborator, you 

can create a project archive. Here's how to do it: 

1. Open your project in Adobe Premiere Pro. 

2. Go to the "File" menu and select "Project Manager". 

3. In the Project Manager window, select the project you want to archive. 

4. Choose the destination folder where you want to save your project archive. 

5. Click on the "Create Archive" button to start the archiving process. 

This will create a single file containing your project and all its associated media files. You can 

then share this file with your collaborators or archive it for future use. 
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Theoretical learning Activity  

Sure, here's a prompt you can use to get your trainees brainstorming about saving and 

sharing projects in Adobe Premiere Pro: 

Prompt: How can you save and share your Adobe Premiere Pro projects with others? 

Instructions: 

1. Divide your trainees into small groups. 

2. Ask them to brainstorm as many ways as they can think of to save and share Adobe 

Premiere Pro projects with others. 

3. Encourage them to think of different methods, such as exporting media files, 

creating project archives, using cloud-based storage solutions, and more. 

4. Give them 5-10 minutes to discuss and come up with their ideas. 

5. Bring the groups back together and have each group share their ideas with the larger 

group. 

6. Encourage discussion and debate among the groups about the different ideas 

presented. 

Some possible ideas that your trainees might come up with include: 

• Exporting a video file in a specific format and sharing it with others via email or file-

sharing platforms like Dropbox or Google Drive. 

• Creating a project archive that includes all media files and project settings, and 

sharing it via cloud storage or USB drive. 

• Using Adobe Creative Cloud to save and share projects with collaborators who also 

have Creative Cloud accounts. 

• Saving a copy of the project on a shared server or network location for team 

members to access and work on. 

• Using third-party project management tools like Trello or Asana to assign tasks and 

track progress on a project. 

• Collaborating on a project in real-time with Adobe Premiere Pro's "Team Projects" 

feature. 

Points to Remember (Take home message) 

 

Sure, here are some points to remember about saving and sharing projects in 
Adobe Premiere Pro: 
Saving a Project: 

1. Save your project frequently to avoid losing any progress. 
2. You can save your project by going to File > Save or using the keyboard 

shortcut Ctrl+S (Windows) or Command+S (Mac). 
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3. Choose a location on your computer to save your project file. 
4. Premiere Pro creates two types of files when you save your project: a 

.prproj file and a folder containing all your media files. 
Sharing a Project: 

1. Before sharing your project, it's important to make sure all your media files 
are properly saved and linked. 

2. You can export your project in different formats such as video files, audio 
files, or project archives. 

3. To export your project, go to File > Export or use the keyboard shortcut 
Ctrl+M (Windows) or Command+M (Mac). 

4. Choose the appropriate settings for your output file such as resolution, 
frame rate, and format. 

5. Premiere Pro provides a wide range of presets that can be used to simplify 
the export process. 

6. After setting the export options, click Export to start the rendering process. 
7. Once the rendering process is complete, you can share the exported file 

with others. 
 
 
 

 

Learning unit 4 formative assessment 

Written assessment 

1. When exporting a project, you can choose the output format and settings. True or False? 
• True 
2. Exporting a project creates a new file while keeping the original project intact. True or 

False? 
• True 
3. Premiere Pro provides no presets for exporting projects. True or False? 
• False. Premiere Pro provides a wide range of presets to simplify the export process. 
4. Once you start exporting a project, you cannot cancel or stop the process. True or False? 
• False. You can stop the export process by clicking the "Stop Queue" button in the export 

window. 
5. Exporting a project is the same as saving a project. True or False? 
• False. Saving a project is a way to save your progress and keep your project intact. Exporting 

a project creates a new file that can be shared with others. 
6. The exported file can be shared with others, uploaded to online platforms, or used for other 

purposes. True or False? 
• True 

 

1. What are some common export settings and options that you might consider when 
exporting a project from Premiere Pro? 
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• Some common export settings and options include choosing the output format and codec, 
selecting the frame rate and resolution, adjusting the bitrate and compression settings, 
adding metadata, and specifying the audio and video settings. 

2. Can you describe the different types of files that can be exported from Premiere Pro and 
what they might be used for? 

• Premiere Pro can export various types of files, including video files, audio files, and project 
archives. Video files can be exported in formats such as MP4, MOV, or AVI, and are 
commonly used for playback on different devices or platforms. Audio files can be exported 
in formats such as WAV or MP3, and are often used for music or podcast production. Project 
archives, on the other hand, are used to save a project and all its associated media files for 
future editing. 

3. What are some best practices for ensuring that your exported file is of high quality and 
suitable for its intended purpose? 

• Some best practices for exporting a high-quality file include using the correct export 
settings, selecting the appropriate codec and bitrate, avoiding over-compression, and 
checking the exported file for quality issues before sharing or uploading. It's also important 
to consider the intended purpose of the exported file and any specific requirements or 
guidelines for that purpose. 

4. How might you customize the export settings to optimize the quality and file size of your 
exported video? 

• To optimize the quality and file size of a video export, you might consider adjusting the 
codec settings, selecting the appropriate bitrate, and adjusting the resolution and frame 
rate. You can also experiment with different compression settings to find the right balance 
between quality and file size. Additionally, Premiere Pro provides a variety of presets that 
can be used to simplify the export process while still achieving high-quality results. 
 

 

 

 

Practical assessment 

Practical Assessment Activity: 

1. Open a project in Adobe Premiere Pro. 
2. Select a sequence to export. 
3. Choose File > Export or use the keyboard shortcut Ctrl+M (Windows) or Command+M 

(Mac). 
4. In the Export Settings window, choose a suitable format and codec for your output file. 
5. Adjust the settings as needed, such as resolution, frame rate, and bitrate. 
6. Review your settings and make any necessary changes to ensure the quality and file size of 

your exported video are optimal. 
7. Click Export to start the rendering process. 
8. Once the rendering process is complete, play back the exported file to ensure the quality is 

satisfactory. 
9. Share the exported file with others or upload it to the desired platform. 
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Checklist: 

• Save your project before exporting to avoid losing any progress. 
• Make sure all media files are properly saved and linked. 
• Choose a suitable format and codec for your output file. 
• Adjust the resolution, frame rate, and bitrate as needed. 
• Check the settings to ensure the quality and file size of your exported video are optimal. 
• Use presets provided by Premiere Pro to simplify the export process. 
• Review your exported file for quality issues before sharing or uploading. 
• Keep in mind the intended purpose of the exported file and any specific requirements or 

guidelines for that purpose. 

References:  

1. Adobe Premiere Pro Help: Export Settings Reference - Adobe provides a 

comprehensive guide to export settings in Premiere Pro, including video and audio 

settings, file formats, and more. https://helpx.adobe.com/premiere-pro/user-

guide.html 

2. Adobe Premiere Pro CC: Video Export Settings Guide for Beginners - A helpful guide 

for beginners to exporting video from Premiere Pro, covering the basics of file 

formats, codecs, resolution, and bitrate. 

https://www.premiumbeat.com/blog/video-export-settings-adobe-premiere-pro/ 

3. How to Export Video in Premiere Pro (Best Settings for Youtube, Vimeo, and more) - 

A video tutorial that explains how to export video from Premiere Pro with specific 

settings for different platforms, such as YouTube and Vimeo. 

https://www.youtube.com/watch?v=4G4KXiW5zQ4 

4. Premiere Pro Export Guide: How to Export for Vimeo, YouTube, and More - A 

comprehensive guide to exporting video from Premiere Pro for different platforms, 

including Vimeo, YouTube, and social media. 

https://www.rocketstock.com/blog/premiere-pro-export-guide-vimeo-youtube-

social-media/ 

5. Premiere Pro Export Tutorial: How to Export in Premiere Pro - A step-by-step tutorial 

on exporting video from Premiere Pro, covering the basics of export settings and 

how to optimize for quality and file size. 

https://www.youtube.com/watch?v=1zZcIUhfZlc 
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